I T FOR BUSINESS & MANAGEMENT

II Semester

COMPLEMENTARY COURSE

For

B B A

(CUCBCSS -2014 admn.)

UNIVERSITY OF CALICUT
SCHOOL OF DISTANCE EDUCATION
Calicut University P.O. Malappuram, Kerala, India 673 635
UNIVERSITY OF CALICUT
SCHOOL OF DISTANCE EDUCATION

STUDY MATERIAL
For
B B A
II Semester
COMPLEMENTARY COURSE

IT FOR BUSINESS & MANAGEMENT

Prepared by & Scrutinized by:

Dr. AJIMS P MOHAMMED
PRINCIPAL (Chairman Board of Studies n Management Studies)
M.E.S. ASMABI COLLEGE
P.Vemballur P.O. Kodungallur
Thrissur Dist., Kerala, Pin 680671

Layout:
Computer Section, SDE

©
Reserved
## CONTENTS

<table>
<thead>
<tr>
<th>CONTENTS</th>
<th>PAGES</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHAPTER - 1</td>
<td>05-16</td>
</tr>
<tr>
<td>CHAPTER - II</td>
<td>17-23</td>
</tr>
<tr>
<td>CHAPTER - III</td>
<td>24-63</td>
</tr>
<tr>
<td>CHAPTER - IV</td>
<td>64-91</td>
</tr>
<tr>
<td>CHAPTER - V</td>
<td>92-101</td>
</tr>
</tbody>
</table>
CHAPTER 1

Introduction to Information Technology

Meaning of Information Technology
Information Technology consists of two words – Information and Technology. Information refers to any communication or representation of knowledge such as facts, data or opinions in any medium or for including textual, numerical, graphic, narrative or audio visual forms. Technology is the practical knowledge or the science of application of knowledge to practical. Thus Information Technology is any equipment or interconnected system or subsystem of equipment that is used in the acquisition, storage manipulation, management transmission or reception of data or information.

IT refers to anything related to computing technology such as networking, hardware, software, the internet or the people that work with these technologies.

Definition of Information Technology
Information Technology can be defined as the technology involving the development, maintenance, and use of computer systems, software, and networks for the processing and distribution of data.

According to UNESCO Information Technology is a scientific, technological and engineering discipline and management technique used in handing the information. Its application and association with social, economic and cultural matters.

IT is a field of engineering involving computer based hardware and software systems, and communication systems, to enable the acquisition, representation, storage, transmission, and use of information. The hardware and software of computing and communication form the basic tool of technology. The web browsers, the operating systems, ERP’s and special purpose applications are the software which is used in Information Technology.

Characteristics of Information Technology
1. Acquisition, storage, manipulation, management, transmission or reception of data or information
2. Real time access to information
3. Easy availability of updated data
4. Connecting geographically dispersed regions
5. Wider range of communication media

IMPORTANCE OF IT
1. Information Technology is useful in ensuring the smooth functioning of all the departments in accompany such as the human resource department, finance department, manufacturing department and in security related purposes.
2. The companies are able to avoid any sort of errors or mistakes in the proper functioning of the tools used for designing and manufacturing purposes.
3. Due to the development of the information technology sector, the companies are being able to keep themselves aware of the changes in the global markets.
4. IT plays an important role in easily solving the mathematical problems and in the project management system.

5. It has a great use in the automated production of sensitive information, automated up-gradation of the important business processes and the automated streamlining of the various business processes.

6. It has also played an important role in the areas of communication and automated administration of entire systems.

APPLICATIONS OF IT IN BUSINESS AND MANAGEMENT

IT has become a vital and integral part of every business plan. From multi-national corporations who maintain mainframe systems and databases to small businesses that own a single computer, IT plays a role. The important applications of information technology in the field of business and management are given as follows.

1. **Product Development**

   Information technology can speed up the time it takes new products to reach the market. Companies can now understand the requirements of consumers by collecting marketing intelligence from proprietary databases, customers and sales representatives. IT helps businesses respond quickly to changing customer requirements.

2. **Process Improvement**

   Process improvement is another important IT application in business. Enterprise resource planning system allow managers to review sales, costs and other operating figures on one integrated software platform, usually in real time. An ERP system can replace a number of traditional systems for finance, human resources and other functional areas.

3. **Communication**

   At present, email is the principal means of communication between employees, suppliers and customers. Communication by email is faster and costs less than sending a paper letter in the mail. IT allows organizing email file folders by client or by type of communication, such as orders or billing.

4. **Marketing**

   One of the main applications of IT is in the area of marketing. Both large and small businesses can now play on a same level and status on the internet. They can have a web site, take orders, buy goods, sell excess or even operate some businesses entirely online.

5. **Inventory Management**

   IT helps business to manage inventory effectively. Organizations are now able to maintain enough stock to meet demand without investing in more than they require. Inventory management systems track the quantity of each item a company maintains, placing an order of additional stock when the quantities fall below a pre-determined reorder level.
6. **Customer Relationship Management**
Companies are using IT to design and manage customer relationships. Customer Relationship Management (CRM) systems capture every interaction a company has with a customer. The entire interaction is stored in the CRM system, ready to be recalled if the customer calls again.

7. **Data Management**
Through IT, companies are able to store and maintain a tremendous amount of historical data economically and employees benefit from immediate access to the documents they need.

8. **Management Information Systems (MIS)**
Storing data is only beneficial if that data can be used effectively. MIS enable companies to track sales data, expenses and productivity levels. The information can be used to track profitability over time, maximize return on investment and identify the areas of improvement.

9. **Globalization**
IT is at the core of operating models essential for globalization, such as telecommuting and outsourcing. A company can outsource most of its noncore functions, such as human resources and finances, to offshore companies and use network technologies to stay in contact with its overseas employees, customers and suppliers.

10. **Competitive Advantage**
Cost savings, rapid product development and process improvements help companies gain and maintain a competitive advantage in the market place. Companies can use rapid prototyping, software simulations and other IT based systems to bring a product to market cost effectively and quickly.

11. **Cost Efficiencies**
Although the initial IT implementation costs can be substantial, that resulting long term cost savings are usually worth the investment. IT allows companies to reduce transaction and implementation costs.

**OFFICE AUTOMATION**
Office automation deals with the application of information technology in office environments to support typical office tasks. The term office automation refers to all tools and methods that are applied to office activities which make it possible to process written, visual, and sound data in a computer aided manner. Office automation involves the planned application of integrated information handling tools and methods to improve the productivity of people in office operations.

Paul Grefen defines “Office automation is the field of business information technology that aims at designing and implementing office information systems from both the perspectives of office organization and information technology”.

Office automation includes the following activities.

- Exchange of information
- Management of administrative documents
OBJECTIVES OF OFFICE AUTOMATION
Office automation is a system that create, store, modify, display and communicate business information in written, verbal or video form. The main objectives of office automation are as follows.

1. To save labour
This is the main reason for office automation. Automation leads in saving labour. Due to office automation the company achieves a reduction in the total wage payment.

2. To save time
Automation is also necessary because it save time in performing various office activities. All the work can be completed within the stipulated time. The time saved can be effectively utilized for other fruitful purposes.

3. To achieve accuracy
One of the main objectives of office automation is to achieve greater accuracy in generating and distributing information. All documents and records kept in the office thus becomes error free.

4. To avoid monotony in office works
Office automation gives great relief to the employees from the monotonous nature of work. The new system improves morale and improves the chances of recruiting better staff for doing the office work.

5. To reduce the chances of committing fraud
The value of office automation lies in the fact it reduces the chances of committing fraud by employees of organization. It is too difficult to commit fraud in automated office system by bad employees.

6. To ensure uniformity in work
Office automation is also necessary to get neat, legible and uniform type of reports and documents. Analysis also will be obtained automatically at the time of entering data in to the record itself.

7. To achieve greater control on information
With the help of office automation, the management can achieve greater control on information. Management gets accurate information quickly so that office work can be performed more efficiently.

OFFICE AUTOMATION PROCESS
Information is a valuable resource to any organization. It should be effectively managed to get maximum results. The success of an organization depends on the availability of the latest information from both the internal and external sources. The proper management information system is thus an important challenge faced by organizations. Information management consists of the following operations.

- Document generation
- Document distribution
ADVANTAGES OF OFFICE AUTOMATION
Office automation has the following advantages.
1. Productivity will be increased. Time consuming office task can be done in shorter time.
2. Office automation helps office to do tasks faster. As a result business can reduce the number of employees.
3. Office automation is advantageous in the form of increased efficiency.
4. Automating information systems reduces storage space, speedy retrieval and allows several employees to access the same data at the same time.
5. Multiple people can be updated simultaneously in the event of scheduled changes.
6. Automation enables people with lower skill levels to perform higher level tasks.
7. An important advantage of office automation is that it is a great money saver for the company. It reduces numerous paper files

DISADVANTAGES OF OFFICE AUTOMATION
1. Old staff members may find it difficult to adjust to the new technology and be unable to use it efficiently.
2. If office work is automated only less number of employees is needed.
3. Older or less skilled employees who are used to manual methods might find it difficult to operate and adjust to automatic processes.
4. Another disadvantage of office automation is that the personal attention that customers expect is lacking.
5. Implementation of technology and related products require huge cost.

VIRTUAL OFFICE
Virtual office is the result of office automation. A Virtual office works just like an ordinary office, but one cannot find any physical space such as buildings, rooms and other facilities in such offices. Employees interact with others through portable communication tools such as electronic mail, cellular phone, voice mail system, laptop computer, fax machines and audio-video conferencing system. Employees are provided with these facilities and they can do their work from any place including their homes.

OFFICE AUTOMATION TECHNOLOGIES
Office automation has a number of applications ranging from internal communication to long distance external communication. Both traditional and modern methods are simultaneously used for handling communication.
Traditional methods include typewriting, cyclostyling, telephone, telex etc. Photocopying, electronic typewriting, printing with the computer, fax, email and voice mail are some of the modern methods used for handling information. The office devices used for handling and communicating information fall under the following groups.
1. Copying and duplicating machines
2. Communicational devices
3. Accounting and calculating machines

1. COPYING AND DUPLICATING MACHINES
Duplicating process may consist of making a single or few copies of outgoing letters or they may involve making large number of copies. There are large numbers of such machines and important among them are following.

A. Typewriter
Traditionally, the typewriter is the most commonly used duplicating machine for correspondence work. Typewriter is a machine in which the characters are produced by steel types striking the paper through an inked ribbon with the types being actuated by corresponding keys on a key board. The paper is being held by a platen that is automatically moved along with a carriage when a key is struck.

Electronic Typewriters
A significant advance in the typewriter field was the development of the electric typewriter, basically a mechanical typewriter with the typing stroke powered by an electric motor drive. The typist initiates the key stroke, the carriage motion and other controls by touching the proper key. The advantage of this system includes lighter touch, faster and more uniform typing, more legible and numerous carbon copies and less operator fatigue.

Portable Typewriters
By the 1950s every typewriter manufacturer produced a portable typewriter; all of them were type bar machines similar in operation to the office machines.

B. Cyclostyling (Stencil)
A stencil is a waxed paper up on which is typed or traced the matter to be duplicated. The typing is done without the ribbon and makes the copies the stencil is fastened to the cylinder attached to the machine over the ink pad. A turn of the handle causes the cylinder to revolve, thus bringing the stencil in contact with the paper which has been fed in to the machine.

C. Photocopier
Photocopier is any device for producing copies of text or graphic material by the use of light, heat, chemicals or electrostatic charges. It is more popularly known as Photostat. Photostat is a machine for the photographic reproduction of letters, maps, drawings, deeds, invoices etc.

D. Fax
Fax is used in telecommunications to transmit and reproduce documents by wire or radio wave. Common fax machines are designed to scan printed textual and graphic material and then transmit the information through the telephone network to similar machines. The documents are reproduced in close to their original form at the destination. Such machines, because of their low cost, reliability, speed, simplicity of operation have revolutionized business and personal correspondence.
E. Word Processing
Word processing is an office automation technology that helps the creation of documents. It also facilitates to edit, format and print documents. Word processing technology makes use of word processing software to perform all these functions. The important word processing packages available are Word Perfect, Word Star and Microsoft Word. Word processing can be used to communicate different kinds of documents such as letters, circulates, reports and other forms of written communications.

F. Desktop Publishing
A desktop publishing system consists of a microcomputer with a high resolution CRT screen, a DTP software and laser printer. The software permits the selection of type fonts and sizes, hyphenation and a right margin justification and layout pages including graphics. Organization can use desktop publishing systems to produce their own printed materials.

G. Document Imaging
Document imaging is widely used in business organizations in order to store documents in the form of digital images. Document imaging is a system that employs digital image processing to store, retrieve and manipulate a digitized image of a document.

H. Personal Computers
Microcomputers have a wide range of applications. Micro computers are extensively used as personal computers. They are designed primarily for the use of professionals and by small business firms. These consist of 8 or 16 bit microprocessors and 1 megabyte of memory. In addition to the CPU, the microcomputer has an operator keyboard for input. Floppy disk drives are used for entering data and programs. A screen is also attached.

I. Workstations
Workstations are expensive computers and it generally employed to run complex programs and display both work in progress and results graphically. Workstations use sophisticated display screens and operating system such as UNIX. Workstations also use powerful networking links to other computers. Workstations are a type of powerful microcomputer used by engineers, scientists and other professionals.

J. Portable Computers
The size of the personal computers has been reducing due to the development in the computer technology. Now computers are becoming smaller and at the same time more powerful. Portable computers are variations of personal computers which can be easily carried around.
There are three types of personal computers namely Laptops or Notebook PCs, Subnotebooks and Personal Digital Computers.
Laptops or Notebooks
Laptops are computers which can be operated either with AC or with battery. These computers are used by people who have to work away from their offices. Executives, students, journalists and sales persons who are always moving place to place can effectively use laptop type of computers.

Subnotebooks
Subnotebook type of computers will have full display screen and keyboard. These computers are weightless and they fit easily in to any briefcase.

Personal Digital Assistants (PDAs)
PDAs are much smaller than the subnotebooks. They combine pen input, writing recognition, personal organization tools and communications capabilities in a very small package. Business executives can effectively use PDAs for doing their day to day activities.

II. COMMUNICATION DEVICES
Communication plays a vital role in an office. An organization need to communicate internally and with outsiders. Postal, telephone, telegram, telex, fax, email, voice systems, conferencing etc. The following are the most commonly used communication devices.

1. Messengers
It is through messengers communications were exchanged in the primitive society. Communication process makes it easier with the introduction of messenger.

2. Postal Service
Postal service is one of the prominent traditional methods of communication still used for receiving and sending information. Postal services make it possible for any person to send a letter, packet, or parcel to any addressee, in the same country or in a foreign country.

3. Telephone
The telephone has become the most widely used telecommunications device. Telephone is an instrument that is designed for the simultaneous transmission and reception of the human voice. Telephone is invented by Alexander Graham Bell.

4. Telegraph
The information age began with the telegraph which was invented by Samuel F B Morse in 1837. This was the first instrument to transform information in to electrical form and transmit it reliably over long distances. India stopped telegraph facility on July 15, 2013 after 163 years service.

5. Telex
Telex is the international telegraphic message transfer service consisting of a network of teleprinters. Subscribers to a telex service can exchange textual communications and data directly with one another. Communication is opened by entering the assigned call number of the destination subscriber using a dial or the teleprinter’s keyboard.
6. Email
Email is a way of sending and receiving messages between users on a network. Email is cheaper as compared to other mode of communication.

7. Voice Systems
The first commercial wireless voice transmitting system utilizing electromagnetic waves, the radio was built in the United States in 1906. Once man learned to encode and decode the human voice in a form that could be superimposed into electromagnetic waves and transmitted to receivers, this communication approach was used directly with human speech.

8. Voice Mail
Voice mail is the system for digitalizing a spoken message and transmitting it over network. It is just like electronic mail except that the sender sends messages in spoken words through telephone rather than typing them.

9. Audio Conferencing
Audio conferencing is the system that uses voice communication technology to establish connection among geographically scattered persons. It allows the participants to conduct a conference among them.

10. Video conferencing
Video conferencing in its basic form is the transmission of image and speech back and forth between two or more physically separate locations. This is accomplished through the use of cameras, video displays, micro phones and speakers.

11. Cellular Phones
Cellular phone is the most widely used communication system of modern periods. It transmit message to another receiver and receives from another transmitter. Communication takes place between the cellular phone and the receiving party through the transceivers.

III. ACCOUNTING AND CALCULATING MACHINES

1. Accounting Machines
Accounting machine is probably the most advanced mechanical device used in business offices. It can post ledgers, make statements and do some arithmetic operations like add and subtract. Among the other records for which accounting machines may be used are purchase journal, distribution journal, general journal, sales journal, general journal, account receivable journal, account payable journal, inventory records etc.

2. Calculator
Calculating machines contribute greatly the efficiency of business office by eliminating routine calculating work. This machine performs all the necessary calculation work. The machine can add, subtract, multiply and divide the figures.

PRINTERS
Most computer systems use printers to produce permanent output in human readable form. Thus computers can produce printed reports and documents such as invoices, payroll, reports and bank statements.

Following are the important classification of printers

A. LINE PRINTERS

Line printers are the high speed printers which print a complete line at a time. The printing speed is at the rate of 300 – 3000 lines per minute. They are mainly used with mini or mainframe computers and used whenever large quantity of output is to be printed. There are two types of line printers namely Drum printers and Chain printers.

Drum Printers

A drum printer consists of a cylindrical drum. The characters to be printed are embossed on its surface. The drum contains a complete raised characters set in each brand around the cylinder. For each character positions of the line, there is a hammer. A wide carbon ribbon and paper are placed between the drum and magnetically driven hammer. The paper is in a continuous sheet which can be separated into individual pages after printing.

Chain Printers

A chain printer has a steel chain on which character set are embossed. Each link of the chain is character font. Hammers are fixed for each point position. For printing a line, all the characters in the line are sent from the memory to the printer. The chain is rotated at high speed. As the chain rotates, a hammer is activated when the desired character comes in front of it. For a printer with 132 characters per line, 132 hammers will be positioned to strike the carbon ribbon which is placed between the chain, paper and hammer.

B. SERIAL PRINTERS

Serial printers print one character at a time. They are similar to typewriters. These printers are normally slow. The printing speed lies in the range of 30 – 600 characters per second depending on the type of printers. They are used with personal computers. Two types of serial printers are available namely dot matrix printers and daisy wheel printers.

Dot Matrix Printers

This is the most popular type of serial printers. A character is printed by printing the selected number of dots from a matrix of dots. Each letter is formed with a series of dots. A character is printing using 5 dot rows and 7 dot columns. This pattern is called 5x7 dot matrixes. In dot matrix printers, small pins are arranged in a rectangular matrix of 5x7.

Daisy Wheel Printers

Daisy wheel printers are very similar to typewriters. The flat, circular printers printing element contains all text and numeric characters. The element spins rapidly, pausing only to allow the printing hammer time to strike the character against the ribbon or paper. Daisy wheel printers are letter quality printers but they tend to be slow.
LASER PRINTERS
This is one of the fastest printers available. It is also known as page or document printer. These type printers can print 120 to 300 pages per minute. Laser printers are capable to produce a report page by page and it also produces high quality printed output including texts and graphics. They also offer a wide variety of character fonts.

INKJET PRINTERS
Ink jet printers work by spraying ionized ink at a sheet of paper. Magnetized plates in the ink’s path direct the ink on the paper in the required shapes. Ink jet printers are suitable for producing high quality print. A typical ink jet printer provides a resolution of 300 dots per inch, although some new models offer better performance. The price of ink jet printers is lower than that of laser printers.

IMPACT AND NON IMPACT PRINTERS
When a part of printer impact or presses the paper to print a character is known as impact printers. It can print a character or line at a time. Dot matrix printer, chain printer and drum printer are included in this type of printer.

A non-impact printer does not strike the paper but ink used for printing is spread by other means. Such printers cannot produce carbon copies of reports at the time of printing. Ink jet printer and laser printer belong to this category.

QUESTIONS
1. Define office automation.
2. What is virtual office?
3. What is text handling?
4. What do you mean by word processing?
5. What do you mean by desktop publishing?
6. What is spreadsheet program?
7. Mention some of the devices used for office communication?
8. What is the role of messenger in communication?
9. Write a note on postal service?
10. State the usefulness of telephone in message communication?
11. What do you understand by Information Technology?
12. Define Information Technology.
13. What is a telegraph?
14. What is email?
15. What is a telex?
16. What do you understand by voice mail?
17. What is audio conferencing?
18. What is video conferencing?
19. What is duplicating machine?
20. What is a photocopier?
21. Mention three types of duplicating machines.
22. What is fax?
23. What do you mean by document imaging?
24. What are accounting machines?
25. What are personal computers?
26. What do you understand by workstations?
27. What is a cellular phone?
28. What is a transceiver?
29. Write a short note on A. Chain printer B. Ink jet printer C. Line printer D. Dot Matrix printer

PARAGRAPH QUESTIONS
1. What do you understand by Information Technology? What are the characteristics of Information Technology?
2. Why office automation is needed?
3. Define Information Technology. What is the importance of IT?
4. What are the different kinds of printers?
5. Distinguish between impact and non-impact printers?
6. What are the objectives of automation?
7. Discuss the office automation process?
8. What are the merits and demerits of office automation?

ESSAY QUESTIONS
1. Define Information Technology. What are the applications of IT in business and management?
2. Define office automation. Discuss the various technologies used in office automation.
3. What is office automation? Explain the objectives and process of office automation?
CHAPTER - 2

MICROSOFT OFFICE

Microsoft Office is an office suite of desktop applications, servers and services for Microsoft Windows and OS X operating systems. It consists of Word, Excel, Access, Power Point, Internet explorer etc. This software is developed to do a specialised job.

M S OFFICE PROGRAMS

1. M S Word:-
   It is used to create various documents like letters, notes, memos and other business documents.

2. M S Excel:-
   It is an electronic spreadsheet programs with data base management facilities. It is used to create charts, graphs, and worksheets.

3. Power Point:-
   It is a presentation program. It is used to create various presentations. Also using this, we can create beautiful colour slides.

4. M S Access:-
   It is used to organise data collections. It can be also used to analyse, sort and summarise data.

5. M S Publisher:-
   It is used for desktop publishing.

6. M S Front Page:-
   It is used to create web pages.

7. Outlook express :-
   It can be used to send and receive e-mails, maintain an appointment calendar, to maintain contact addresses and telephone numbers.

MICROSOFT WORD

It is a constituent of SMS office software. Microsoft Word is a word processor and was previously considered the main program in Office. M S Word is a word processor with which we can create notes, memos, letters, bus documents, books, letter and internet web pages. Word is more than an electronic typewriter. It transcends simple word processing to multifunctional programs.

USES OF M S WORD

1. To create desktop publishing documents.
2. To build hypertext documents.
3. Twist text into funky shapes.
4. To insert objects or wrap around graphics.
5. To build multicolumn, multi row tables.
6. Use the equation editor to insert and manipulate numerical data.
7. To store and reuse readymade content and formatted elements.
8. To design different documents such as resumes or invitation cards.

CONTENTS:-

THE RIBBON
It is at the top portion of the document.

**It includes 8 tabs**

1. **File**
   This file option include create new document, open an existing document, save or save as and print.

2. **Home**
   It includes clipboard, fonts, paragraph, styles and editing.

3. **Insert**
   Pages, tables, illustrations, Links, header and footer, text and symbols.

4. **Page Layout**
   Themes, pages setup, page background, paragraph, arrange.

5. **References**
   Table of contents, footnote, citation and bibliography, captions, index and table of authorities.

6. **Mailings**
   It includes create envelopes, start mail merge, write and insert fields, preview results and finish and merge.

7. **Review**
   It includes spelling and grammar check, translation to different languages, word counts etc.

8. **View**
   It includes print layout full screen reading web layout ruler, zooming option etc

**Minimize and Maximize the Ribbon**

1. Click the arrow in the upper right corner of the Ribbon to minimize it.
2. To maximize the Ribbon, click the arrow again.

**Customize the Ribbon**

It is possible to customize the Ribbon by creating our own tabs. We can create as many groups as we want in order to keep tab organized. We can even add commands to any of the default tabs. The stages are :-

a) Right click the Ribbon and select customize the Ribbon.

b) Click the new tab. A new tab will be create with a new group inside it..

c) Make sure the new group is selected.

d) Select a command from the list on the left, then click add.

e) When you are done adding commands, click OK

**BACK STAGE VIEW**

This option gives you various options for saving, opening a file, printing, or sharing your document. It is similar to the office button menu from word 2007 or the file menu from earlier versions of word. The stages are:-

a) Click the file tab.

b) Choose an option on the left side of the page.

c) To get back to your document, just click any tab on the ribbon.

**The quick Access toolbar**

It is located above the ribbon. It contains common commands such as Save, Undo, and Repeat commands. We can add other commands to make our work more convenient. For this firstly click the drop down arrow to the right of the quick access toolbar and select the
command that we want to add from the drop down menu. Then it will appear in the quick access toolbar.

**The Ruler**

It is located at the top and to the left of document. We can hide and view the ruler.

**CREATE AND OPENING DOCUMENTS**

Word files are called documents. **To create a new, blank document:**

1. Click the file tab. This takes you to backstage view.
2. Select new.
3. Select blank document under available templates. It will be highlighted by default.

**Open an existing document.**

1. Click the file tab. This takes you to backstage view.
2. Select open. The open dialog box appears.
3. Select your document, and then click open.

**WORKING WITH TEXT**

The basics of working with text include typing, reorganizing, and editing text. There are a number of functions while working with text. Text boxes will give you control over the position of a block of text in your document. You can place text boxes anywhere in the document and format them with shading and borders. Additionally, you can link text boxes so that the contents flow between the boxes automatically.

Click **Insert>>Text Box** to insert a text box. Click and drag your mouse where you would like to position the text box. It appears with a border that you can use to resize or reposition the text box.

**SELECTING THE TEXT**

To change any attributes of text it must be highlighted first. Select the text by dragging mouse over the desired text while keeping the left mouse button depressed or hold down the SHIFT key on the key board while using the arrow buttons to highlight the text.

**DELETING TEXT**

Use the BACKSPACE and DELETE keys on the keyboard to delete text. Backspace will delete text to the left of the cursor and Delete will erase text to the right.

**COPY AND PASTE TEXT**

We can copy text from one area of the document and place that text elsewhere in the document. As with cut data, copied data is stored on the clipboard.

**CUT AND PASTE**

We can cut text from one area of a document and save that text so it can be pasted elsewhere in the document. To rearrange text within a document, you can utilize the clipboard group on the home tab of the Ribbon.

**FIND AND REPLACE**

If we need to find a particular word or piece of text especially with longer documents, we can use the Find command. The steps required are:-

a) From the home tab, click the Find command.

b) Type the text you wish to find in the field at the top of the Navigation pane.

c) If the text is found in the document, it will be highlighted in yellow, and a preview will appear in the navigation pane.
d) If the text appears more than once you can click the arrows on the navigation pane to step through the results. You can also click the result previews on the navigation pane to jump to the location of a result in your document.

e) When you close the navigation pane, the highlighting will disappear.

In order to **replace text** the following steps are required:-

a) From the home tab, click the replace command. The find and replace dialog box will appear.

b) Type the text you wish to find in the find what field.

c) Type the text you wish to replace it with in the replace with field.

d) Clicks find next and then replace to replace text. You can also click replace all to replace all instances within the document.

**FORMATTING TEXT**

Formatting of text will enhance the style of our document. A style is a format enhancing tool that includes font typeface, font size, effects (bold, italics, underline, etc.), colours and more.

**Font:**

In work we can change the font. Click the arrow head to the right of the font name box to view the list of fonts available. Scroll down to the font you want and select it by clicking on the name once with the mouse. We can change font size, type and colour.

**Bold, underline, and italicize:**

We can bold, underline, or italicize the text when using work.

**Change case:**

We can capitalize letters by changing their case, by applying small capital or all capital formatting or by creating a large letter at the beginning of a paragraph.

**SAVE DOCUMENTS**

After creating a new document in word, it is necessary to save it in order to access and edit later. There are different ways to save documents:-

a) **Save as command:**

b) It is useful if you have first created a document or if you want to save a different version of a document while keeping the original.

c) **Save command:** For using this, click the save command on the quick access toolbar and it will be saved in its current location with the same file name.

**Auto Recover**

This option on the word automatically saves documents to a temporary folder while working on them. If you forget to save your changes or if word crashes, you can recover the auto saved file. By default, word auto saves every 10 minutes.

**PAGE LAYOUT**

This option is used when the default page layout settings in word are not sufficient for your document. In such cases we can modify those settings. Word offers variety of page layout and formatting and formatting options. We can customize the page orientation, page size, and page margins depending on our document to appear.

Page orientation involves two options such as portrait and landscape page orientation. Page size can change according to our option and also page margins; we can specify our own option.
SPELL CHECK AND GRAMMAR CHECK
Word will automatically check for spelling and grammar errors as we type unless we turn this feature off. Spelling errors are noted in the document with a red underline and grammar errors are by a green underline.

PRINTING
After we have finished the typing and formatting, we need to print it. It helps to get required number of copies of our document. If we want to print something with a single click, we can use the quick print option. To print the following steps are followed:-
1. Go to the Print page
2. Type the range of pages.
3. Select the number of copies.
4. Check the collate box if you are printing multiple copies of a multi-page document.
5. Select a printer from the drop-down list.
6. Click the print button.

MAIL MERGE
It is a software operation describing the production of multiple (and potentially large numbers of) documents from a single template form and a structured data source. The letter may be sent out to many "recipients" with small changes, such as a change of address or a change in the greeting line. Steps are:-
Click the "Mailings" tab to open the Mail Merge tools.
Click the "Start Mail Merge" button and select your format.
Click "Select Recipients" and select how you want to add recipients to the Mail Merge.

MICROSOFT POWER POINT
Visual images are a highly useful and effective media to present ideas to a group of audience Power point uses slides to build a presentation. In order to create an engaging presentation, power point allows you to add text, bulleted lists, images, charts, video, and more to your slides. You can add as many slides as you’d like to a presentation. And at any time you can view or play back your presentation by selecting one of the slide show play options.

CREATING AND OPENING PRESENTATIONS
Power point files are called presentations. Whenever we start a new project in power point, we have to create a new presentation.

CREATING A NEW PRESENTATION
1. Click the file tab.
2. Select new.
3. Select blank presentation under available templates and themes.
4. Click creates. A new, blank presentation appears in the power point window.

OPENING AN EXISTING PRESENTATION
1. Click the file tab
2. Select open
3. Select the presentation that we want to open, and then click open.

SLIDES
Power point provides many features required to produce professional looking presentation. A power point presentation is made up of a series of slides. The slides contain the
information to communicate with audience. This information can include text, pictures, charts, video, sound, and more.

SLIDE LAYOUTS
A slide layout arranges the content using different types of placeholders, depending on the kind of information that we want to include in our presentation. Each layout has a descriptive name.

MANAGING SLIDES
Power point provides a variety of views and tools to organize and prepare slideshow. Slide view; organize slides into section, adding notes to slides etc involved in it. Slide views are of normal view, slide sorter view, slide sorter view, reading view and slide show view.

MANAGING TEXTS
The importance of power point presentation is the quality of text contained in it. Therefore, it is necessary to know the basics of working with text so that we can add and arrange text on slides.

There are various options like insert, delete, move, and format text as well as how to use text boxes.

POWER POINT TEMPLATES
Power point 2010 allows applying built in templates, to apply custom templates, and to search from a variety of templates available on office.com. Office.com provides a wide selection of popular power point templates, including presentations and design slides.

POWER POINT THEMES
It is a convenient way to add a professional look to our presentation. A theme is a predefined combination of colours fonts and effects that can be applied to our presentation. Themes provide attractive backgrounds for your power point slides.

ADDING IMAGES
Adding images to your presentations makes them more interesting and engaging. Pictures, clip art, and screen shots can be inserted into power point to help you effectively communicate your ideas to your audience.

INSERTING TABLES FOR CHARTS
Tables and charts can be used to express data in a presentation.

HYPERLINKS
Hyper links are used to allow a presenter a way to access a website during the presentation by pressing a link inserted into the slide. Adding hyperlinks to your presentation can help your reader quickly access contact information or information from the internet.

SLIDE NUMBER
A presentation may include plenty of slides. In such cases, it will be easy to locate specific slides if we give slide numbers on these slides.

DATE AND TIME
Date and time can also be inserted in slides in the same way as we did in the case of slide number. Make sure that the slide tab is selected within the header and footer dialog box.

RECORDED SOUND OR NARRATION
We can add our own narration to the slides so that the presentation can be left running while you are busy with other matters. Sound effects can also be created using the recording feature.
SAVING PRESENTATIONS
After creating a new presentation in power point, we can save it in order to access and edit it later. Power point allows you to save your presentation in a number of ways.

PRINTING SLIDES
One new feature in power point 2010 is the file tab. This tab incorporates many of the features in the 2003 and 2007 versions of power point but makes them much more user friendly.

SLIDE TRANSITIONS
Slide transitions are like the effects used in films to change from scene to scene. Power point provides several transition methods. We can add sound to a transition and can control its speed. We can apply a transition to selected slides or to all slides in our presentation.

SLIDE ANIMATIONS
Slide animations create animated effects to text and graphics during a slide show. There are a variety of animations that can be applied to text or graphics in multiple ways from a single word to all of the text on a slide.

SLIDE SHOW
The best way to view your slides as a show, go to the slide show tab on the Ribbon.

QUESTIONS
1. What are power point templates?
2. What is text box?
3. What is a slide?
4. What is normal view?
5. What is slide sorter view?
6. What is presentation?
7. What do you mean by themes?
8. Explain how you would insert tables in presentation?
9. How you insert hyper link in a presentation?
10. What is slide show?
11. What is slide transition?
CHAPTER – 3

SPREADSHEET

A spreadsheet is an interactive computer application program for organization, analysis and storage of data in tabular form. Spreadsheets developed as computerized simulations of paper accounting worksheets. The program operates on data represented as cells of an array, organized in rows and columns. Each cell of the array is a model–view–controller element that may contain either numeric or text data, or the results of formulas that automatically calculate and display a value based on the contents of other cells.

Application of spreadsheets includes:

- Preparation of reports
- Payrolls management
- Preparation of bills
- Income statements
- Budget analysis
- Loan analysis
- Investment analysis
- Inventory control
- Production analysis etc.,

Features of spreadsheet

Some of the features available within a spreadsheet that make it a good tool for modeling include:-

- **Supports the idea of variables**
  This is essential in order to change input values and alter pre-set numbers in the model such as VAT rate or tax levels.

- **Use of formulas**
  A model needs to be able to do maths on the input values and this is just what formulas can do.

- **Use of functions**
  This is a real time-saver as spreadsheets have hundreds of functions you can use for building up the model - for instance there is a function that can do compound interest calculations. If it did not support functions then you would have to do all the hard calculations yourself by using formulas.

- **Supports Goal Seek**
  This is a very powerful feature where the goal-seek feature will find the correct input value given what you want the answer to be. It is like running the model backwards in time.

- **Provides a wide range of Graphs**
  A model is often concerned with not just getting a single answer, but also needs to show how that answer is reached over time. Graphs are an ideal way of doing this.

- **Dynamic calculation**
A spreadsheet is very fast on a modern computer, so you can set up a powerful model with thousands of calculations and yet you can expect an answer very quickly.

**Advantages of spreadsheet**

Following are the important benefit of using spreadsheet
- It produces accurate results.
- Easy and quick calculation
- Worksheet data can be displayed and manipulated
- Data can be converted into graph
- Entire worksheet or parts can be printed
- Facilities carrying ‘what if’ Analysis
- Data in a worksheet can be transferred to other programmes easily.

**Spreadsheet Packages**

There are many spreadsheet packages like SSuiteAccel, Gnumeric, GS-Calc, KSpread, Lotus 1-2-3, Microsoft Excel, OpenOffice.org Calc, Resolver One etc.

Microsoft Excel is the most popular one.

**MICROSOFT EXCEL**

Microsoft Excel is an electronic spreadsheet. As with a paper spreadsheet, you can use Excel to organize your data into rows and columns and to perform mathematical calculations. Spreadsheets can do more than perform simple arithmetic calculations. A spreadsheet can translate complicated data and reports into a combination of numbers and graphs.

**Parts of the Excel 2007 Screen**
Active Cell

In an Excel 2007 worksheet, the cell is with the black outline. Data is always entered into the active cell.

Column Letter
Columns run vertically on a worksheet and each one is identified by a letter in the column header.

Formula Bar
Located above the worksheet, this area displays the contents of the active cell. It can also be used for entering or editing data and formulas.

Name Box
Located next to the formula bar, the Name Box displays the cell reference or the name of the active cell.

Row Numbers
Rows run horizontally in a worksheet and are identified by a number in the row header. Together a column letter and a row number create a cell reference. Each cell in the worksheet can be identified by this combination of letters and numbers such as A1, F456, or AA34.

Sheet Tabs
By default there are three worksheets in an Excel file. The tab at the bottom of a worksheet tells you the name of the worksheet - such as Sheet1, Sheet2 etc. Switching between worksheets can be done by clicking on the tab of the sheet you wish to access. Renaming a worksheet or changing the tab color can make it easier to keep track of data in large spreadsheet files.

Quick Access Toolbar
This customizable toolbar allows you to add frequently used commands. Click on the down arrow at the end of the toolbar to display the available options.

Office Button
Clicking on the Office Button displays a drop down menu containing a number of options, such as open, save, and print. The options in the Office Button menu are very similar to those found under the File menu in previous versions of Excel.

Ribbon
The Ribbon is the strip of buttons and icons located above the work area in Excel 2007. The Ribbon replaces the menus and toolbars found in earlier versions of Excel.

In the upper-left corner of the Excel 2007 window is the Microsoft Office button. When you click the button, a menu appears. You can use the menu to create a new file, open an existing file, save a file, and perform many other tasks.

The Quick Access Toolbar

Next to the Microsoft Office button is the Quick Access toolbar. The Quick Access toolbar gives you with access to commands you frequently use. By default, Save, Undo, and Redo
appear on the Quick Access toolbar. You can use Save to save your file, Undo to roll back an action you have taken, and Redo to reapply an action you have rolled back.

**The Title Bar**
Next to the Quick Access toolbar is the Title bar. On the Title bar, Microsoft Excel displays the name of the workbook you are currently using. At the top of the Excel window, you should see "Microsoft Excel - Book1" or a similar name.

**The Ribbon**

![Image of the Ribbon in Microsoft Excel](image)

You use commands to tell Microsoft Excel what to do. In Microsoft Excel 2007, you use the Ribbon to issue commands. The Ribbon is located near the top of the Excel window, below the Quick Access toolbar. At the top of the Ribbon are several tabs; clicking a tab displays several related command groups. Within each group are related command buttons. You click buttons to issue commands or to access menus and dialog boxes. You may also find a dialog box launcher in the bottom-right corner of a group. When you click the dialog box launcher, a dialog box makes additional commands available.

**To start MS EXCEL**—To start Microsoft Excel, from the Taskbar, click

Start > (All) Programs -> Microsoft Office -> Microsoft Office Excel

**Work Sheet**
Microsoft Excel consists of **worksheets**. Each worksheet contains **columns** and **rows**. The columns are lettered A to Z and then continuing with AA, AB, AC and so on; the rows are numbered 1 to 1,048,576. The number of columns and rows you can have in a worksheet is limited by your computer memory and your system resources. A box formed by the intersection of column and row is called as **Cells**

**Work Book**
Work book is a collection of worksheets used in a single file. In other words, each file in a Microsoft excel is known as work book.

The combination of a column coordinate and a row coordinate make up a cell address. For example, the cell located in the upper-left corner of the worksheet is cell A1, meaning column A, and row 1. Cell E10 is located under column E on row 10. You enter your data into the cells on the worksheet.

**The Formula Bar**
If the Formula bar is turned on, the cell address of the cell you are in displays in the Name box which is located on the left side of the Formula bar. Cell entries display on the right side of the Formula bar. If you do not see the Formula bar in your window, perform the following steps:
1. Choose the View tab.
2. Click Formula Bar in the Show/Hide group. The Formula bar appears. The current cell address displays on the left side of the Formula bar.

**The Status Bar**

The Status bar appears at the very bottom of the Excel window and provides such information as the sum, average, minimum, and maximum value of selected numbers. You can change what displays on the Status bar by right-clicking on the Status bar and selecting the options you want from the Customize Status Bar menu.

![Status Bar](image)

**Move around the Worksheet**

**The Down Arrow Key**
Press the down arrow key several times. Note that the cursor moves downward one cell at a time.

**The Up Arrow Key**
Press the up arrow key several times. Note that the cursor moves upward one cell at a time.

**The Tab Key**
1. Move to cell A1.
2. Press the Tab key several times. Note that the cursor moves to the right one cell at a time.

**The Shift Tab Keys**
Hold down the Shift key and then press Tab. Note that the cursor moves to the left one cell at a time.

**The Right and Left Arrow Keys**
1. Press the right arrow key several times. Note that the cursor moves to the right.
2. Press the left arrow key several times. Note that the cursor moves to the left.

**Page Up and Page Down**
1. Press the Page Down key. Note that the cursor moves down one page.
2. Press the Page Up key. Note that the cursor moves up one page.

**The Ctrl-Home Key**
1. Move the cursor to column J.
2. Stay in column J and move the cursor to row 20.
3. Hold down the Ctrl key while you press the Home key. Excel moves to cell A1.

**Go To Cells Quickly**

The following are shortcuts for moving quickly from one cell in a worksheet to a cell in a different part of the worksheet.

**For eg: Go to G5**
The G5 function key is the "Go To" key. If you press the G5 key, you are prompted for the cell to which you wish to go. Enter the cell address, and the cursor jumps to that cell.
1. Press G5. The Go To dialog box opens.
2. Type **J3** in the Reference field.

**The Name Box**
You can also use the Name box to go to a specific cell. Just type the cell you want to go to in the Name box.

1. Type **B10** in the Name box.

**Select Cells**

If you wish to perform a function on a group of cells, you must first select those cells by highlighting them. The exercises that follow teach you how to select.
To select cells A1 to E10:
1. Go to cell A1.
2. Press the F8 key. This anchors the cursor.
3. Note that "Extend Selection" appears on the Status bar in the lower-left corner of the window. You are in the Extend mode.
5. Press Esc and click anywhere on the worksheet to clear the highlighting.

**Alternative Method: Select Cells by Dragging**

You can also select an area by holding down the left mouse button and dragging the mouse over the area. In addition, you can select noncontiguous areas of the worksheet by doing the following:

1. Go to cell A1.
2. Hold down the Ctrl key. You won't release it until step 9. Holding down the Ctrl key enables you to select noncontiguous areas of the worksheet.
3. Press the left mouse button.
4. While holding down the left mouse button, use the mouse to move from cell A1 to C5.
5. Continue to hold down the Ctrl key, but release the left mouse button.
6. Using the mouse, place the cursor in cell D7.
7. Press the left mouse button.
8. While holding down the left mouse button, move to cell F10. Release the left mouse button.
9. Release the Ctrl key. Cells A1 to C5 and cells D7 to F10 are selected.
10. Press Esc and click anywhere on the worksheet to remove the highlighting.

**Enter Data**

In order to enter data, first, place the cursor in the cell in which you want to start entering data. Type some data, and then press Enter. If you need to delete, press the Backspace key to delete one character at a time.

1. Place the cursor in cell A1.
2. Type **Manohar**. Do not press Enter at this time.

**Delete Data**
The Backspace key erases one character at a time.
*Press the Backspace key until **Manohar** is erased.

**Edit a Cell**
After you enter data into a cell, you can edit the data by pressing F2 while you are in the cell you wish to edit.
Change "John" to "Jones."
1. Move to cell A1.
2. Press F2.
3. Use the Backspace key to delete the "n" and the "h."
4. Type **nes**.
5. Press Enter.

**Editing a Cell by Using the Formula Bar**
You can also edit the cell by using the Formula bar. You change "Jones" to "Joker" in the following exercise.

1. Move the cursor to cell A1.
2. Click in the formula area of the Formula bar.
3. Use the backspace key to erase the "s," "e," and "n."
4. Type **ker**.
5. Press Enter

**By Double-Clicking in the Cell**
You can change "Joker" to "Johnson" as follows:
1. Move to cell A1.
3. Press the End key. Your cursor is now at the end of your text.

3. Use the Backspace key to erase "r," "e," and "k."
4. Type Johnson.
5. Press Enter.

**Wrap Text**

When you type text that is too long to fit in the cell, the text overlaps the next cell. If you do not want it to overlap the next cell, you can wrap the text.
1. Type **Text too long to fit**.
2. Press Enter.
3. Return to cell A2.
4. Choose the Home tab.
5. Click the Wrap Text button. Excel wraps the text in the cell.

**Delete a Cell Entry**
To delete an entry in a cell or a group of cells, you place the cursor in the cell or select the group of cells and press Delete.
1. Select cells A1 to A2.
2. Press the Delete key.

**Save a File**
To save your file:
1. Click the Office button. A menu appears.
2. Click Save. The Save As dialog box appears.
3. Go to the directory in which you want to save your file.
4. Type **name of file** in the File Name field.
5. Click Save. Excel saves your file.

**Close Excel**
Close Microsoft Excel.
1. Click the Office button. A menu appears.
2. Click Close. Excel closes.

**Formatting of Worksheet**

**Convert Text to Columns**
Sometimes you will want to split data in one cell into two or more cells. You can do this easily by utilizing the Convert Text to Columns Wizard.
Highlight the column in which you wish to split the data, Click the **Text to Columns** button on the **Data** tab, Click **Delimited** if you have a comma or tab separating the data, or click fixed widths to set the data separation at a specific size.
Modify Fonts
Modifying fonts in Excel will allow you to emphasize titles and headings. To modify a
font: Select the cell or cells that you would like the font applied. On the Font group on the
Home tab, choose the font type, size, bold, italics, underline, or color.

Format Cells Dialog Box
In Excel, you can also apply specific formatting to a cell. To apply formatting to a cell or
group of cells:
Select the cell or cells that will have the formatting
Click the Dialog Box arrow on the Alignment group of the Home tab.
There are several tabs on this dialog box that allow you to modify properties of the cell or cells.

**Number:** Allows for the display of different number types and decimal places

**Alignment:** Allows for the horizontal and vertical alignment of text, wrap text, shrink text, merge cells and the direction of the text.

**Font:** Allows for control of font, font style, size, color, and additional features

**Border:** Border styles and colors

**Fill:** Cell fill colors and styles

**Add Borders and Colors to Cells**

Borders and colors can be added to cells manually or through the use of styles. To add borders manually:

Click the **Borders** drop down menu on the **Font** group of the **Home** tab

Choose the appropriate border

To apply colors manually:

Click the **Fill** drop down menu on the **Font** group of the **Home** tab

Choose the appropriate color

To apply borders and colors using styles:

Click **Cell Styles** on the **Home** tab

Choose a style or click **New Cell Style**

---

**Change Column Width and Row Height**

To change the width of a column or the height of a row:

Click the **Format** button on the **Cells** group of the **Home** tab

Manually adjust the height and width by clicking **Row Height** or **Column Width**

To use **AutoFit** click **AutoFit Row Height** or **AutoFit Column Width**
Hide or Unhide Rows or Columns
To hide or unhide rows or columns:
Select the row or column you wish to hide or unhide
Click the Format button on the Cells group of the Home tab
Click Hide & Unhide

Merge Cells
To merge cells select the cells you want to merge and click the Merge & Center button on the Alignment group of the Home tab. The four choices for merging cells are:
- Merge & Center: Combines the cells and centers the contents in the new, larger cell
- Merge Across: Combines the cells across columns without centering data
- Merge Cells: Combines the cells in a range without centering
- Unmerge Cells: Splits the cell that has been merged
Align Cell Contents
To align cell contents, click the cell or cells you want to align and click on the options within the
Alignment group on the Home tab. There are several options for alignment of cell contents:
Top Align: Aligns text to the top of the cell
Middle Align: Aligns text between the top and bottom of the cell
Bottom Align: Aligns text to the bottom of the cell
Align Text Left: Aligns text to the left of the cell
Center: Centers the text from left to right in the cell
Align Text Right: Aligns text to the right of the cell
Decrease Indent: Decreases the indent between the left border and the text
Increase Indent: Increase the indent between the left border and the text
Orientation: Rotate the text diagonally or vertically

Insert and Delete Columns and Rows

To delete columns F and G:
1. Click the column F indicator and drag to column G.
2. Click the down arrow next to Delete in the Cells group. A menu appears.
3. Click Delete Sheet Columns. Excel deletes the columns you selected.
4. Click anywhere on the worksheet to remove your selection.
To delete rows 7 through 12:
1. Click the row 7 indicator and drag to row 12.
2. Click the down arrow next to Delete in the Cells group. A menu appears.
3. Click Delete Sheet Rows. Excel deletes the rows you selected.
4. Click anywhere on the worksheet to remove your selection.

To insert a column:
1. Click on A to select column A.
2. Click the down arrow next to Insert in the Cells group. A menu appears.
3. Click Insert Sheet Columns. Excel inserts a new column.
4. Click anywhere on the worksheet to remove your selection.

To insert rows:
1. Click on 1 and then drag down to 2 to select rows 1 and 2.
2. Click the down arrow next to Insert in the Cells group. A menu appears
3. Click Insert Sheet Rows. Excel inserts two new rows.
4. Click anywhere on the worksheet to remove your selection.

Your worksheet should look like the one shown here.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>Add</td>
<td>Subtract</td>
<td>Multiply</td>
<td>Divide</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>2</td>
<td>8</td>
<td>4</td>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>1</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>3</td>
<td>5</td>
<td>12</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Printing the worksheet
To print a work sheet, open the workbook containing the worksheet. Click the sheet tab of
the worksheet to be printed.
Click “print” on file menu
Excel displays the print dialogue box. Excel allows printing a range of selected active
worksheet or the entire work book. It is also possible to print a range of pages in excel.

FUNCTIONS AND FORMULAS IN EXCEL
A function is a predetermined formula in excel. It performs calculation by using specific
values,
Called arguments, in a particular order, or structure. For example, the —SUM function
adds values or ranges of cells and the —PMT function calculates the loan payments based
on the interest rate, length of loan and the principal amount etc.

Locate the Function Library panel:
Performing Mathematical Calculations

A major strength of Excel is that you can perform mathematical calculations and format your data. In Microsoft Excel, you can enter numbers and mathematical formulas into cells. Whether you enter a number or a formula, you can reference the cell when you perform mathematical calculations such as addition, subtraction, multiplication, or division. When entering a mathematical formula, precede the formula with an equal sign. Use the following to indicate the type of calculation you wish to perform: + Addition, - Subtraction, * Multiplication, / Division, ^ Exponential etc.,

**Addition**

1. Type Add in cell A1.
2. Press Enter. Excel moves down one cell.
3. Type 1 in cell A2.
4. Press Enter. Excel moves down one cell.
5. Type 1 in cell A3.
6. Press Enter. Excel moves down one cell.
8. Click the check mark on the Formula bar. Excel adds cell A1 to cell A2 and displays the result in cell A4. The formula displays on the Formula bar.

**Subtraction**

1. Press F5. The Go To dialog box appears.
2. Type B1 in the Reference field.
4. Type Subtract.
5. Press Enter. Excel moves down one cell.
6. Type 6 in cell B2.
7. Press Enter. Excel moves down one cell.
8. Type 3 in cell B3.
9. Press Enter. Excel moves down one cell.
10. Type =B2-B3 in cell B4.
11. Click the check mark on the Formula bar. Excel subtracts cell B3 from cell B2 and the result displays in cell B4. The formula displays on the Formula bar.

**Multiplication**

1. Hold down the Ctrl key while you press "g" (Ctrl+g). The Go To dialog box appears.
2. Type C1 in the Reference field.
3. Press Enter. Excel moves to cell C1
4. Type Multiply.
5. Press Enter. Excel moves down one cell.
6. Type 2 in cell C2.
7. Press Enter. Excel moves down one cell.
8. Type 3 in cell C3.
9. Press Enter. Excel moves down one cell.
10. Type =C2*C3 in cell C4.
11. Click the check mark on the Formula bar. Excel multiplies C1 by cell C2 and displays the result in cell C3. The formula displays on the Formula bar.

**Division**

1. Press F5.
2. Type D1 in the Reference field.
4. Type Divide.
5. Press Enter. Excel moves down one cell.
6. Type 6 in cell D2.
7. Press Enter. Excel moves down one cell.
8. Type 3 in cell D3.
9. Press Enter. Excel moves down one cell.
10. Type =D2/D3 in cell D4.
11. Click the check mark on the Formula bar. Excel divides cell D2 by cell D3 and displays the result in cell D4. The formula displays on the Formula bar.

When creating formulas, you can reference cells and include numbers. All of the following formulas are valid:

\[ \frac{A2}{B2} \]
\[ A1 + 12 - B3 \]
\[ A2 \times B2 + 12 \]
\[ 24 + 53 \]

**AutoSum**

You can use the AutoSum button on the Home tab to automatically add a column or row of numbers. When you press the AutoSum button, Excel selects the numbers it thinks you want to add. If you then click the check mark on the Formula bar or press the Enter key, Excel adds the numbers. If Excel's guess as to which numbers you want to add is wrong, you can select the cells you want. The following illustrates AutoSum.

1. Go to cell F1.
2. Type 3.
3. Press Enter. Excel moves down one cell.
4. Type 3.
5. Press Enter. Excel moves down one cell.
6. Type 3.
7. Press Enter. Excel moves down one cell to cell F4.
8. Choose the Home tab.
9. Click the AutoSum button in the Editing group. Excel selects cells F1 through F3 and enters a formula in cell F4.

```
<table>
<thead>
<tr>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>9</td>
</tr>
</tbody>
</table>
```

10. Press Enter. Excel adds cells F1 through F3 and displays the result in cell F4.

**Perform Automatic Calculations**

By default, Microsoft Excel recalculates the worksheet as you change cell entries. This makes it easy for you to correct mistakes and analyze a variety of scenarios. Make the changes described below and note how Microsoft Excel automatically recalculates.

1. Move to cell A2.
2. Type 2.
3. Press the right arrow key. Excel changes the result in cell A4. Excel adds cell A2 to cell A3 and the new result appears in cell A4.
5. Type 8.
6. Press the right arrow key. Excel subtracts cell B3 from cell B3 and the new result appears in cell B4.
7. Move to cell C2.
8. Type 4.
9. Press the right arrow key. Excel multiplies cell C2 by cell C3 and the new result appears in cell C4.
10. Move to cell D2.
11. Type 12.
12. Press the Enter key. Excel divides cell D2 by cell D3 and the new result appears in cell D4.

**Advanced Calculations**

1. Move to cell A7.
2. Type =3+3+12/2*4.
3. Press Enter. Microsoft Excel divides 12 by 2, multiplies the answer by 4, adds 3, and then adds another 3. The answer, 30, displays in cell A7.
To change the order of calculation, use parentheses. Microsoft Excel calculates the information in parentheses first.

2. Edit the cell to read \((3+3+12)/2*4\).
3. Press Enter.

Microsoft Excel adds 3 plus 3 plus 12, divides the answer by 2, and then multiplies the result by 4. The answer, 36, displays in cell A7.

**Absolute Cell Addressing**

You make a cell address an absolute cell address by placing a dollar sign in front of the row and column identifiers. You can do this automatically by using the F4 key. To illustrate:

1. Move to cell C12.
2. Type =.
3. Click cell C9.
5. Type +.
6. Click cell C10.
8. Type +.
9. Click cell C11.
11. Click the check mark on the formula bar. Excel records the formula in cell C12.

**Financial functions**

Microsoft Excel provides a series of functions designed to perform various types of financially related operations. These functions use common factors depending on the value that is being calculated. Many of these functions deal with investments or loan financing.

**Present Value** – It is the current value of an investment or a loan. The initial value that the customer deposits or has in the account is the Present Value. If the customer is making
deposits, this value must be negative. If the customer is receiving money (interest, rent, lottery installments, etc.), then this value should be positive.

**Future Value**- it is the value the loan or investment will have when the loan is paid off or when the investment is over. To calculate the future value of an investment, you can use the FV() function. The syntax of this function is:

Function FV (Rate, Periods, Payment, Present Value, Payment Type) As Currency

The **Number of Periods** is the number of payments that make up a full cycle of a loan or an investment. The Interest **Rate** is a fixed percent value applied during the life of the loan or the investment. The rate does not change during the length of the **Periods**.

It is very important to understand how these two arguments are passed to a function. The period could be the number of months of a year, which is 12; but it could be another length. Suppose a customer is getting a car loan that would be financed in 5 years. This is equivalent to 5 * 12 = 60 months. In the same way, a cash loan can stretch from 0 to 18 months, a carpenter truck loan can have a life financing of 40 months, and a condominium can be financed for 15 years of 12 months plus an additional 8 months; this is equivalent to (15 * 12) + 8 = 188 months. Start a new workbook and fill up Sheet1 as follows:

1. Save it as Business
2. Double-click Sheet1 to put its label into edit mode. Type Future Value and press Enter
3. Click cell C8
4. On the Ribbon, click Formulas.
   In the Function Library section, click Financial and click FV.
5. Move the Function Arguments dialog box so you can see the values on the worksheet
6. Click the box to the right of Rate and, on the worksheet, click cell C5 and type /12
7. In the Function Arguments dialog box, click the box to the right of Nper and, on the worksheet, click cell C7
8. In the Function Arguments dialog box, click the box to the right of Pmt and type -
9. On the worksheet, click cell C6
10. In the Function Arguments dialog box, click the box to the right of Pv and type -
11. On the worksheet, click cell C4
12. Since this is a loan, the payments are expected at the end of the month. Therefore, in the Function Arguments dialog box, click the box to the right of Type and type 0
13. Click OK

The Number of Periods (NPER) is the number of payments that make up a full cycle of loan or an investment. To calculate the number of periods of an investment or a loan, you can use the NPER() function. Its syntax is: Function NPER (Rate, Payment, Present Value, Future Value, and Payment Type) As Currency

Here is an example:
Investment or Loan Payment

The PMT() function is used to calculate the regular payment of loan or an investment. Its syntax is:

Function PMT (Rate, Periods, Present Value, Future Value, Payment Type) As Currency

In the following example, a customer is applying for a car loan. The cost of the car will be entered in cell C4. It will be financed at a rate entered in cell C6 for a period set in cell C7. The dealer estimates that the car will have a value of $0.00 when it is paid off.

Calculating the Monthly Payments of a Loan

1. Double-click Sheet3 to put it in edit mode. Type Payments Amount and press Enter.
2. Complete the worksheet as follows

3. Click cell C8 and type =PMT(.
4. Click cell C6 and type /12,
5. Click cell C7 and type ,-
6. Click cell C4 and type ,
7. Click cell C5
8. Type ,0) and, on the Formula Bar, click the Enter button.

The Amount Paid As Interest During a Period

The IPMT () function is used to calculate the amount paid as interest on a loan during a period of the lifetime of a loan or an investment. It is important to understand what this function calculates.
Suppose a customer is applying for a car loan and the salesperson decides (or agrees with the customer) that the loan will be spread over 5 years (5 years * 12 months each = 60 months). The salesperson then applies a certain interest rate.

The syntax of the IPMT () function is:

Function IPMT (Rate, Period, NPeriods, Present Value, Future Value, Payment Type) As Double

The Rate argument is a fixed percent value applied during the life of the loan. The Present Value is the current value of the loan or investment. It could be the marked value of the car, the current mortgage value of a house, or the cash amount that a bank is lending. The Future Value is the value the loan or investment will have when the loan is paid off. The N Periods is the number of periods that occur during the lifetime of the loan.

Calculating the Monthly Payments of a Loan

1. To add a new worksheet, click the button on the right side of the Payment Amounts tab
2. Double-click the new Sheet4 tab to put it in edit mode
3. Type Periodic Interest Earned and press Enter
4. Complete the worksheet as follows

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Affordable Car Center</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Car Value</td>
<td>17540</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Interest Rate</td>
<td>9.15%</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Period</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Nbr of Periods</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Future Value</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Interest Earned</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5. Click cell C9 and type =IPMT( 
6. Click cell C5 and type /12, 
7. Click cell C6 and type , 
8. Click cell C7 and type ,
9. Click cell C4 and type , 
10. Click cell C8 and type ,0) 
11. On the Formula Bar, click the Enter button
12. Save the workbook

**The Amount Paid as Principal**

While the `IPMT()` function calculates the amount paid as interest for a period of a loan or an investment, `PPMT()` function calculates the actual amount that applies to the balance of the loan. This is referred to as the principal. Its syntax is:

Function `PPMT (Rate, Period, NPeriods, Present Value, Future Value, Payment Type)` As `Currency`

The arguments are the same as described in the previous sections.

**Evaluating amount paid as principal**

Change the Periodic Interest Earned worksheet as follows:

1. Click cell C10 and type `=PPMT(`
2. Click cell C5 and type `/12`,
3. Click cell C6 and type `,`
4. Click cell C7 and type `,`
5. Click cell C4 and type ,
6. Click cell C8 and type ,
7. Type ,0) and, on the Formula Bar, click the Enter button

8. Save the workbook

The PV () function calculates the total amount that a future investment is worth currently. Its syntax is: Function PV (Rate, NPeriods, Payment, Future Value, and Payment Type) As Currency

The arguments are the same as described earlier. RATE() function is used to calculate the interest applied on a loan or an investment. Its syntax is: Function RATE (NPeriods, Payment, Present Value, Future Value, Payment Type, and Guess) As Double

All of the arguments are the same as described for the other functions, except for the Guess. This argument allows you to give some type of guess for a rate. This argument is not required. If you omit it, its value is assumed to be 10.

**Calculating the interest rate**

1. To add a new worksheet, click the button on the right side of the Periodic Interest Earned tab
2. Double-click the new Sheet5 tab to put it in edit mode
3. Type Interest Rate and press Enter
4. Change the Interest Rate worksheet as follows

5. Click cell C8 and type =-RATE(
6. Click cell C7 and type ,
7. Click cell C6 and type ,-
8. Click cell C4 and type ,
9. Click cell C5 and type ,0)*12 and, on the Formula Bar, click the Enter button

10. Use the Percent Style button in the Number section of the Home tab of the Ribbon to make the value display as a percentage value
11. Save the workbook

**The IRR () function**

This function is used to calculate an internal rate of return based on a series of investments. Its syntax is: Function IRR (Values, Guess) As Double

The Values argument is a series (also called an array or a collection) of cash amounts that a customer has made on an investment. For example, a customer could make monthly deposits in a savings or credit union account. Another customer could be running a business.
and receiving different amounts of money as the business is flowing (or losing money). The cash flows don't have to be the same at different intervals but they should (or must) occur at regular intervals such as weekly (amount cut from a paycheck), bi-weekly (401k directly cut from paycheck), monthly (regular investment), or yearly (income). The Values argument must be passed as a collection of values, such as a range of selected cells, and not an amount. Otherwise you would receive an error.

The Guess parameter is an estimate interest rate of return of the investment.

Calculating the Internal Rate of Return
1. To add a new worksheet, click the button on the right side of the other tab sheets
2. Double-click the new Sheet1 tab to put it in edit mode. Type Internal Rate of Return and press Enter
3. Change the worksheet as follows

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td>Yugo &amp; Associates</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Investment Goal</td>
<td>-7500.00</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>1st Month</td>
<td>1500.00</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>2nd Month</td>
<td>2050.00</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>3rd Month</td>
<td>1800.00</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>4th Month</td>
<td>1250.00</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>5th Month</td>
<td>2400.00</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>6th Month</td>
<td>2450.00</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Guess</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Internal Rate of Return</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4. Click cell D12 and type =IRR( 
5. Select cells D4:D10 and, on the Formula Bar, click the Enter button
6. In cell D11, type 12 and click cell D12
7. In the Formula Bar, change the function to =IRR(D4:D10, D11) and press Enter (you shouldn't see any significant difference unless you change the range of cells such as D4:D8)
8. Save the workbook

The Net Present Value
The NPV () function uses a series of cash flows to calculate the present value of an investment. Its syntax: Function NPV (Rate, Value1, Value2 ...) As Currency
The Rate parameter is the rate of discount during one period of the investment. Any payment made in the past should have a positive value (because it was made already). Any future payment should have a negative value (because it has not been made yet).

Calculating the Net Present Value

1. To add a new worksheet, click the button on the right side of the other tab sheets
2. Double-click the new Sheet7 tab to put it in edit mode
3. Type Net Present Value and press Enter
4. Complete the worksheet as follows:

5. Click cell D14 and type = NPV(
6. Click cell D13 and type ,
7. Select cells D4:D12 and, on the Formula Bar, click the Enter button
8. Save the workbook

**ISPMT function**

It calculates the interest paid during a specific period of an investment. Its syntax is given below:

ISPMT (Rate, Per, Nper, PV)

- **Rate** – interest rate for the investment
- **Per** – period for which we want to find the interest, and must be between 1 and nper
- **Nper** – total number of payment period
- **PV** – is the present value of investment.

**Excel Statistical Functions**

Excel's Statistical Functions can be used to analysis the data in a spreadsheet. For example, they can be used to tell you the number of data entries you have or the average value of your data. There are number of statistical functions in excel. The uses of some of the statistical functions are explained below.
Covar
In Excel, the Covar function returns the covariance, the average of the products of deviations for two data sets. The syntax for the Covar function is: **Covar (array1, array2)** array1 and array are two ranges or arrays of integer values. For example: Let's take a look at an example: =Covar({1,2;3,4}, {5,6;7,8}) The above example would return 1.25.

Forecast
In Excel, the Forecast function returns a prediction of a future value based on existing values provided. The syntax for the Forecast function is: **Forecast(x-value, known_y_values, known_x_values)** x-value is the xvalue used to predict the y-value. Known_y_values is the known y-values used to predict the y-value.

Intercept
In Excel, the Intercept function returns the y-axis intersection point of a line using x-axis values and y-axis values. The syntax for the Intercept function is: **Intercept (known_y_values, known_x_values)** known_y_values is the known y-values used to calculate the intersect. Known_x_values is the known x values used to calculate the intercept.

Median
In Excel, the Median function returns the median of the numbers provided. The syntax for the Median function is: **Median (number1, number2, number_n)** number1, number2, number_n are numeric values - they can be numbers, named ranges, arrays, or references to numbers. There can be up to 30 values entered.

Percentile
In Excel, the Percentile function returns the nth percentile from a set of values. The syntax for the Percentile function is: **Percentile (array, nth_percentile)** array is a range or array from which you want to return the nth percentile. Nth_percentile is the percentile value. It can be a value between 0 and 1. Note: If nth_percentile is not a numeric value, the Percentile function will return the
#VALUE! error. If nth_percentile is a value greater than 1 or less than 0, the Percentile function will return the #NUM! error.

Quartile

In Excel, the Quartile function returns the quartile from a set of values. The syntax for the Quartile function is: **Quartile (array, nth_quartile)** array is a range or array from which you want to return the nth quartile. Nth_quartile is the quartile value that you wish to return. It can be one of the following values: ValueExplanation 0 Smallest value in the data set 1 First quartile (25th percentile) 2 Second quartile (50th percentile) 3 Third quartile (75th percentile) 4 largest value in the data set Note: If nth_quartile is not an integer, it will be truncated.

Rank

In Excel, the Rank function returns the rank of a number within a set of numbers. The syntax for the Rank function is: **Rank (number, array, order)** number is the number to find the rank for. Array is a range or array of numbers to use for ranking purposes. Order is optional. It specifies how to rank the numbers. If order is 0, it ranks numbers in descending order. If order is not 0, it ranks numbers in ascending order. If the order parameter is omitted, the Rank function assumes order is 0 (descending order)

StDev

In Excel, the StDev function returns the standard deviation of a population based on a sample of numbers. The syntax for the StDev function is: **StDev( number1, number2 ... number_n )** number1, number2, ... number_n are numeric values - they can be numbers, named ranges, arrays, or references to numbers. There can be up to 30 values entered.

CORREL

In Excel, CORREL calculates the correlation coefficient of the array of cell ranges. In other words this function returns the correlation coefficient of two sets of variables. Its syntax is :=CORREL (array1, array2) . An example is given below
Finding large, small, average etc in EXCEL

MAX
Returns the largest value from a list of supplied numbers
= MAX (number1, number2,)

MAXA
Returns the largest value from a list of supplied values, counting text and the logical value FALSE as the value 0 and counting the logical value TRUE as the value 1

MIN
Returns the smallest value from a list of supplied numbers
=MIN ( number1,number2,)

MINA
Returns the smallest value from a list of supplied values, counting text and the logical value FALSE as the value 0 and counting the logical value TRUE as the value 1

LARGE
Returns the Kth LARGEST value from a list of supplied numbers, for a given value K

SMALL
Returns the Kth SMALLEST value from a list of supplied numbers, for a given value K

AVERAGE
Returns the Average of a list of supplied numbers
=AVERAGE (number1,number2,........)

AVERAGEA
Returns the Average of a list of supplied numbers, counting text and the logical value FALSE as the value 0 and counting the logical value TRUE as the value 1

AVERAGEIF
Calculates the Average of the cells in a supplied range, that satisfy a given criteria

AVERAGEIFS
Calculates the Average of the cells in a supplied range, that satisfy multiple criteria
Database in worksheet

Database is a collection of related data organized in a meaningful manner. Data are stored in tables in database. A table is a collection of related records. Each record contains a number of fields. Only flat database can be created in excel. In a flat database, column represents fields and row represents record. A database can be created anywhere in a worksheet. But it must be separated from other data in the worksheet so as to recognize the database. Following rules must be observed for creating database in excel.

- The first row of DB must be used for field names (column headings)
- Field name must be unique.
- Records must be entered without leaving any empty row between field names and the first record in the DB
- Each row must contain one full record

Let us see an inventory database

A number of database functions are available in excel. Excel Database Functions are used to interrogate lists of data held on a worksheet. For a selected table they will perform their processing
only on records (or Rows) which meet specified criteria. These functions make Excel Project very
versatile spreadsheet software indeed. Some of database function in excel are given here;

DAverage
In Excel, the DAverage function averages all numbers in a column in a list or database,
Based on a given criteria. The syntax for the DAverage function is: DAverage (range, field, criteria) range is the range of cells that you want to apply the criteria against. Field is the column to
average the values. You can either specify the numerical position of the column in the list or the
column label in double quotation marks. Criteria are the range of cells that contains your criteria.

DCount
In Excel, the DCount function returns the number of cells in a column or database that
Contains numbers and meets a given criteria. The syntax for the DCount function is: DCount( range, field, criteria )

DCountA
In Excel, the DCountA function returns the number of cells in a column or database that
Contains nonblank values and meets a given criteria. The syntax for the DCountA function is:
DCountA( range, field, criteria ) range is the range of cells that you want to apply the criteria
against.

DGet
In Excel, the DGet function retrieves from a database a single record that matches a given criteria.
The syntax for the DGet function is: DGet (database, field, criteria) database is the
Range of cells that you want to apply the criteria against. Field is the column to retrieve.

DMax
In Excel, the DMax function returns the largest number in a column in a list or database, based
On a given criteria. The syntax for the DMax function is: DMax( database, field, criteria )

DMIN
In Excel, the DMin function returns the smallest number in a column in a list or database, based
Based on a given criteria. The syntax for the DMin function is: DMin( database, field, criteria ) database is the range of cells that you want to apply the criteria against.

DProduct
In Excel, the DProduct function returns the product of the numbers in a column in a list or
Database, based on a given criteria. The syntax for the DProduct function is: DProduct( database, field, criteria ) database is the range of cells that you want to apply the criteria
Against.

DStDev
In Excel, the DStDev function returns the standard deviation of a population based on a sample
of numbers in a column in a list or database, based on a given criteria. The syntax for the
DStDev function is: \( \text{DStDev(database, field, criteria)} \) database is the range of cells that you want to apply the criteria against.

\**DStDevP**

In Excel, the DStDevP function returns the standard deviation of a population based on the entire population of numbers in a column in a list or database, based on a given criteria. The Syntax for the DStDevP function is: \( \text{DStDevP(database, field, criteria)} \) database is the range of cells that you want to apply the criteria against.

\**DSum**

In Excel, the DSum function sums the numbers in a column or database that meets a given criteria. The syntax for the DSum function is: \( \text{DSum(range, field, criteria)} \) range is the range of cells that you want to apply the criteria against. Field is the column to sum the values.

\**DVar**

In Excel, the DVar function returns the variance of a population based on a sample of numbers in a column in a list or database, based on a given criteria. The syntax for the DVar function is: \( \text{DVar(database, field, criteria)} \) database is the range of cells that you want to apply the criteria against.

\**DVarP**

In Excel, the DVarP function returns the variance of a population based on the entire population of numbers in a column in a list or database, based on a given criteria. The syntax for the DVarP function is: \( \text{DVarP(database, field, criteria)} \)

**Goal Seek in Excel**

Goal Seek is used to get a particular result when you're not too sure of the starting value. For Example, if the answer is 56 and the first number is 8, what is the second number? Is it 8 multiplied by 7, or 8 multiplied by 6? You can use Goal Seek to find out. We'll try that example to get you started, and then have a go at a more practical example.

Create the following Excel spreadsheet

In the spreadsheet above, we know that we want to multiply the number in B1 by the number in B2. Then the number in cell B2 is the one we're not too sure of. The answer is going in cell B3. Our
answer is wrong at the moment, because we have a Goal of 56. To use Goal Seek to get the answer, try the following:

- From the Excel menu bar, click on Data
- Locate the Data Tools panel and the What if Analysis item. From the What if Analysis Menu, select Goal Seek
- The following dialogue box appears:

The first thing Excel is looking for is "Set cell". This is not very well named. It means "Which cell contains the Formula that you want Excel to use". For us, this is cell B3. We have the following formula in B3: \( = B1 \times B2 \)

So enter B3 into the "Set cell" box, if it's not already in there. The "To value" box means "What answer are you looking for"? For us, this is 56. So just type 56 into the "To value" box. The "By Changing Cell" is the part you're not sure of. Excel will be changing this part. For us, it was cell B2. We weren't sure which number, when multiplied by 8, gave the answer 56. So type B2 into the box. You Goal Seek dialogue box should look like:

Click OK and Excel will tell you if it has found a solution:

Click OK again, because Excel has found the answer. Your new spreadsheet will look like this one:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Number Certain</td>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Number Unsure</td>
<td>7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Answer We Want</td>
<td></td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
As you can see, Excel has changed cell B2 and replace the 6 with a 7 - the correct answer.

**Scenarios in Excel**

Scenarios come under the heading of "What-If Analysis" in Excel. They are similar to tables in that you are changing values to get new results. For example, What if I reduce the amount I'm spending on food? How much will I have left then? Scenarios can be saved, so that you can apply them with a quick click of the mouse. A Scenario offers you different ways to view a set of figures, and allows you to switch between them quite easily. To create scenarios in Excel 2007, carry out the following steps:

- Create the values on the basis of which you wish to create the original scenario.
- Select the cells in which the data is likely to change.
- Go to the 'Data' tab.
- Click 'What-If Analysis' tool appearing under the 'Data Tools' group.
- Click the 'Scenario Manager ....' option from the drop-down list.
- Click the 'Add' button appearing on the 'Scenario Manager' dialog box.
- Enter a scenario name and click 'OK' to close the dialog box.
- Check the values that are assigned to the scenario.

**Creating Charts in excel**

Charts helps by converting numeric data into visual display. Once the numbers are converted into charts and graphs, it is easy to identify its trend and pattern. In Microsoft Excel, you can represent numbers in a chart. On the Insert tab, you can choose from a variety of chart types, including column, line, pie, bar, area, and scatter. The basic procedure for creating a chart is the same no matter what type of chart you choose.

As you change your data, your chart will automatically update.

**Create a Column Chart**

1. Select cells A3 to D6. You must select all the cells containing the data you want in your chart. You should
2. Also include the data labels.
3. Choose the Insert tab.
4. Click the Column button in the Charts group. A list of column chart sub-types appears.
5. Click the Clustered Column chart sub-type. Excel creates a Clustered Column chart and the Chart Tools
Apply a Chart Layout

Context tabs are tabs that only appear when you need them. Called Chart Tools, there are three chart context tabs: Design, Layout, and Format. The tabs become available when you create a new chart or when you click on a chart. You can use these tabs to customize your chart. You can determine what your chart displays by choosing a layout. For example, the layout you choose determines whether your chart displays a title, where the title displays, whether your chart has a legend, where the legend displays, whether the chart has axis labels and so on. Excel provides several layouts from which you can choose.

Apply a Chart Layout

1. Click your chart. The Chart Tools become available.
2. Choose the Design tab.
3. Click the Quick Layout button in the Chart Layout group. A list of chart layouts appears.
4. Click Layout 5. Excel applies the layout to your chart.

Add Labels

When you apply a layout, Excel may create areas where you can insert labels. You use labels to give your chart a title or to label your axes. When you applied layout 5, Excel created label areas for a title and for the vertical axis.
1. Select Chart Title. Click on Chart Title and then place your cursor before the C in Chart and hold down the Shift key while you use the right arrow key to highlight the words Chart Title.
2. Type Toy Sales. Excel adds your title.
3. Select Axis Title. Click on Axis Title. Place your cursor before the A in Axis. Hold down the Shift key while you use the right arrow key to highlight the words Axis Title.
4. Type Sales. Excel labels the axis.
5. Click anywhere on the chart to end your entry.

Switch Data
If you want to change what displays in your chart, you can switch from row data to column data and vice versa
1. Click your chart. The Chart Tools become available.
2. Choose the Design tab.
3. Click the Switch Row/Column button in the Data group. Excel changes the data in your chart.

Change the Style of a Chart
A style is a set of formatting options. You can use a style to change the color and format of your chart. Excel 2007 has several predefined styles that you can use. They are numbered from left to right, starting with 1, which is located in the upper-left corner.
1. Click your chart. The Chart Tools become available.
2. Choose the Design tab.
3. Click the More buttons in the Chart Styles group. The chart styles appear.
4. Click Style you want. Excel applies the style to your chart.

Change the Size and Position of a Chart
When you click a chart, handles appear on the right and left sides, the top and bottom, and the corners of the chart. You can drag the handles on the top and bottom of the chart to increase or decrease the height of the chart. You can drag the handles on the left and right sides to increase
or decrease the width of the chart. You can drag the handles on the corners to increase or decrease the size of the chart proportionally. You can change the position of a chart by clicking on an unused area of the chart and dragging.

1. Use the handles to adjust the size of your chart.
2. Click an unused portion of the chart and drag to position the chart beside the data.

**Change the Chart Type**

Any change you can make to a chart that is embedded in a worksheet, you can also make to a chart sheet. For example, you can change the chart type from a column chart to a bar chart.

1. Click your chart. The Chart Tools become available.
2. Choose the Design tab.
3. Click Change Chart Type in the Type group. The Chart Type dialog box appears.
4. Click Bar.
5. Click Clustered Horizontal Cylinder.
6. Click OK. Excel changes your chart type.

**Questions**

1. What is spreadsheet? What are its features?
2. What are the parts of a worksheet?
3. What are the mathematical functions in Excel?
4. What are the important financial function in Excel?
5. Explain some of the statistical functions in Excel?
6. Explain about Goal seek and Scenario functions in Excel?
7. How do you create a chart and graph in Excel?
8. How do you format a worksheet in Excel?
CHAPTER 4
DATABASE SYSTEM

Introduction
Databases and database systems are an essential component of life in modern society: most of us encounter several activities every day that involve some interaction with a database. For example, if we go to the bank to deposit or withdraw funds, if we make a hotel or airline reservation, if we access a computerized library catalog to search for a bibliographic item, or if we purchase something online—such as a book, toy, or computer—chances are that our activities will involve someone or some computer program accessing a database. Even purchasing items at a supermarket often automatically updates the database that holds the inventory of grocery items.

A Database is a shared collection of related data which is used to support the activities of a particular organization. A database can be viewed as a repository of data that is defined once and then is accessed by various users.

A database has the following implicit properties:

- A database represents some aspect of the real world, sometimes called the miniworld. Changes to the miniworld are reflected in the database.
- A database is a logically coherent collection of data with some inherent meaning. A random assortment of data cannot correctly be referred to as a database.
- A database is designed, built, and populated with data for a specific purpose. It has an intended group of users and some preconceived applications in which these users are interested.

Characteristics of Database Systems

1. Self-Describing Nature of a Database System
   A Database System contains not only the database itself but also a complete definition or description of the database structure and constraints. This definition is stored in the DBMS catalog, which contains information such as the structure of each file, the type and storageformat of each data item, and various constraints on the data. The information stored in the catalog is called meta-data.

2. Insulation between Program and Data and Data Abstraction
   In the file based system, the structure of the data files is defined in the application programs so if a user wants to change the structure of a file, all the programs that access that file might need to be changed as well. On the other hand, in the database approach, the data structure is stored in the system catalog not in the programs. Therefore, one change is all that’s needed. We call this property program-data independence.

3. Sharing of Data and Multiuser Transaction Processing
A multiuser database system must allow multiple users access to the database at the same time. The multiuser DBMS must have concurrency control strategies to ensure several users access to the same data item at the same time, and to do so in a manner that the data will always be correct – data integrity. The DBMS must include concurrency control software to ensure that several users trying to update the same data do so in a controlled manner so that the result of the updates is correct.

**DBMS**

A database management system (DBMS) is a collection of programs that enables users to create and maintain a database. The DBMS is a general-purpose software system that facilitates the processes of defining, constructing, manipulating, and sharing databases among various users and applications. Defining a database involves specifying the data types, structures, and constraints of the data to be stored in the database. The database definition or descriptive information is also stored by the DBMS in the form of a database catalog or dictionary; it is called meta-data.

**Figure:** A simplified database
System environment.
DBMS Component Modules
A DBMS is a very complex software system that consists of many components, or modules, including modules for implementing the catalog, query language processing, interface processing, accessing and buffering data, controlling concurrency, and handling data recovery and security. The DBMS must interface with other system software such as the operating system and compilers for various programming languages.

The top part of the figure refers to the various users of the database environment and their interfaces. The lower part shows the internals of the DBMS responsible for storage of data and processing of transactions.

The database and the DBMS catalog are usually stored on disk. Access to the disk is controlled primarily by the operating system (OS), which schedules disk read/write. Many DBMSs have their own buffer management module to schedule disk read/write, because this has a considerable effect on performance.
Three main components of DBMS are;

1. Data definition language (DDL)
   The contents of database are created by using the DDL. It defines relationship between different data elements and serves as an interface for application programmes that uses data.

2. Data Manipulation Language (DML)
   Data processed and updated by using a language called data manipulation language. It allows a user to query database and receive summary or customized reports. DML is usually integrated with other programming languages.

3. Data Dictionary
   Data dictionary contains schema of the database. It defines each data item in the database, lists its structure, source, persons authorized to modify it etc. in other words it gives metadata ie, data about data, through which the end user data are integrated and managed.

**Database Administrator**

In any organization where many people use the same resources, there is a need for achieve administrator to oversee and manage these resources. In a database environment, the primary resource is the database itself, and the secondary resource is the DBMS and related software. Administering these resources is the responsibility of the database administrator (DBA).

DBA coordinates all the activities of the database system; the database administrator has a good understanding of the enterprise’s information resources and needs.

His duties include:

- Schema definition
  The Database Administrator creates the database schema by executing DDL statements. Schema includes
  - the logical structure of database table (Relation) like data types of attributes, length of attributes,
  - Integrity constraints etc.
  - Storage structure and access method definition
  Database tables or indexes are stored in the following ways: Flat files, Heaps, B+ Tree etc.
  - Schema and physical organization modification
  - Granting user authority to access the database
  The DBA provides different access rights to the users according to their level. Ordinary users might have highly restricted access to data, while you go up in the hierarchy to the administrator, you will get more access rights.
- Specifying integrity constraints
- Acting as liaison with users
- Monitoring performance and responding to changes in requirements
• **Routine Maintenance**  
  Some of the routine maintenance activities of a DBA include; taking backup of database periodically, ensuring enough disk space is available all the time.

**Advantages of Using the DBMS Approach**

• **Controlling Redundancy**  
  In traditional software development utilizing file processing, every user group maintains its own files for handling its data-processing applications. This redundancy in storing the same data multiple times leads to several problems such as duplication of effort, wastage of storage space, inconsistency in data.

• **Restricting Unauthorized Access**  
  When multiple users share a large database, it is likely that most users will not be Authorized to access all information in the database. Hence, the type of access operation—retrieval or update—must also be controlled.

• **Providing Persistent Storage for Program Objects**  
  Databases can be used to provide persistent storage for program objects and data structures. This is one of the main reasons for object-oriented database systems. A complex object in C++ can be stored permanently in an object-oriented DBMS. Such an object is said to be persistent, since it survives the termination of program execution and can later be directly retrieved by another C++ program.

• **Providing Storage Structures and Search Techniques for Efficient Query Processing**  
  Database systems must provide capabilities for efficiently executing queries and updates. Because the database is typically stored on disk, the DBMS must provide specialized data structures and search techniques to speed up disk search for the desired records. Auxiliary files called indexes are used for this purpose.

• **Providing Backup and Recovery**  
  A DBMS must provide facilities for recovering from hardware or software failures. The backup and recovery subsystem of the DBMS is responsible for recovery.

• **Providing Multiple User Interfaces**  
  Because many types of users with varying levels of technical knowledge use a database, a DBMS should provide a variety of user interfaces.

• **Representing Complex Relationships among Data**  
  A database may include numerous varieties of data that are interrelated in many ways. A DBMS must have the capability to represent a variety of complex relationships among the data, to define new relationships as they arise, and to retrieve and update related data easily and efficiently.
Permitting Inference and Actions Using Rules

Some database systems provide capabilities for defining deduction rules for inference new information from the stored database facts. Such systems are called deductive database systems.

RELATIONAL DATABASE SYSTEM

A relational database management system (RDBMS) is a database management system (DBMS) that is based on the relational model as introduced by E. F. Codd. In relational model, data is represented in terms of tuples (rows).

RDBMS is used to manage Relational database. Relational database is a collection of organized set of tables from which data can be accessed easily. Relational Database is most commonly used database. It consists of number of tables and each table has its own primary key.

In Relational database, a table is a collection of data elements organized terms of rows and columns. A table is also considered as convenient representation of relations. But a table can have duplicate tuples while a true relation cannot have duplicate tuples.

When a relation is thought of as a table of values, each row in the table represents a collection of related data values. A row represents a fact that typically corresponds to a real-world entity or relationship.

In the formal relational model terminology, a row is called a tuple, a column header is called an attribute, and the table is called a relation. The data type describing the types of values that can appear in each column is represented by a domain of possible values. Primary Key is an attribute whose values are used to uniquely identify tuples in the relation (in the following table, ID is the primary key)

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Age</th>
<th>Salary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Adam</td>
<td>34</td>
<td>13000</td>
</tr>
<tr>
<td>2</td>
<td>Alex</td>
<td>28</td>
<td>15000</td>
</tr>
<tr>
<td>3</td>
<td>Stuart</td>
<td>20</td>
<td>18000</td>
</tr>
<tr>
<td>4</td>
<td>Ross</td>
<td>42</td>
<td>19020</td>
</tr>
</tbody>
</table>

Popular Relational Database Packages

Most popular databases currently in use are based on the relational database model.

Examples of currently available soft wares are - 4th Dimension, Adabas D, Black Ray, CA-Data com, Clarion, Clustrix, CSQL, , DataEase IBM DB2 Express-C Infobright, Mckoi SQL Database, Microsoft Access, Microsoft Jet Database Engine (part of Microsoft Access, Microsoft SQL Server,
Microsoft SQL Server Express, SQLBase, SQLite, Sybase Adaptive Server Enterprise, XSPRADA, Zoduna Data Store (Designed for mobile platform) etc.,

DATABASE SECURITY

Database security concerns the use of a broad range of information security controls to protect databases (potentially including the data, the database applications or stored functions, the database systems, the database servers and the associated network links) against compromises of their confidentiality, integrity and availability.

Security risks to database systems include:

- Unauthorized or unintended activity or misuse by authorized database users, database Administrators, or network/systems managers, or by unauthorized users or hackers (e.g. Inappropriate access to sensitive data, metadata or functions within databases, or inappropriate changes to the database programs, structures or security configurations);
- Malware infections causing incidents such as unauthorized access, leakage or disclosure of personal or proprietary data, deletion of or damage to the data or programs, interruption or denial of authorized access to the database, attacks on other systems and the unanticipated failure of database services;
- Overloads, performance constraints and capacity issues resulting in the inability of authorized users to use databases as intended;
- Physical damage to database servers caused by computer room fires or floods, overheating, lightning, accidental liquid spills, static discharge, electronic breakdowns/equipment failures and obsolescence;
- Design flaws and programming bugs in databases and the associated programs and systems, creating various security vulnerabilities (e.g. unauthorized privilege escalation), data loss/corruption, performance degradation etc.;
- Data corruption and/or loss caused by the entry of invalid data or commands, mistakes in database or system administration processes, sabotage/criminal damage etc.

Control Measures

Four main control measures are used to provide security of data in databases:

- Access control, User Accounts, and Database Audits
- Inference control
- Flow control
- Data encryption

A security problem common to computer systems is that of preventing unauthorized persons from accessing the system itself, either to obtain information or to make malicious changes in a portion of the database. The security mechanism of a DBMS must include provisions for restricting access
to the database system as a whole. This function, called **access control**, is handled by creating user accounts and passwords to control the login process by the DBMS.

Whenever a person or a group of persons needs to access a database system, the individual or group must first apply for a **user account**. The DBA will then create a new **account number** and **password** for the user if there is a legitimate need to access the database. The user must **log in** to the DBMS by entering the account number and password whenever database access is needed. The DBMS checks that the account number and password are valid; if they are, the user is permitted to use the DBMS and to access the database.

**Statistical databases** are used to provide statistical information or summaries of values based on various criteria. For example, a database for population statistics may provide statistics based on age groups, income levels, household size, education levels, and other criteria. Statistical database users such as government statisticians or market research firms are allowed to access the database to retrieve statistical information about a population but not to access the detailed confidential information about specific individuals. Security for statistical databases must ensure that information about individuals cannot be accessed. It is sometimes possible to deduce or infer certain facts concerning individuals from queries that involve only summary statistics on groups; consequently, this must not be permitted either. This problem, called statistical database security, the corresponding control measures are called **inference control measures**.

Another security issue is that of **Flow Control**, which prevents information from flowing in such a way that it reaches unauthorized users. Channels that are pathways for information to flow implicitly in ways that violate the security policy of an organization are called covert channels.

A final control measure is **Data Encryption**, which is used to protect sensitive data (such as credit card numbers) that is transmitted via some type of communications network. Encryption can be used to provide additional protection for sensitive portions of a database as well. The data is encoded using some coding algorithm.

**Digital signature** and Digital certificate - Digital signatures are commonly used for software distribution, financial transactions, and in other cases where it is important to detect forgery or tampering. A digital signature or digital signature scheme is a mathematical scheme for demonstrating the authenticity of a digital message or document.

**Integrity control** means keeping the data consistent and correct by means of controls that a database administrator puts on the database. Only persons with privileged accounts can load data into the database. Even with that, there are rules on the table fields that allow only a certain type of data to be inserted.

In information technology, a **backup** or the process of backing up is making copies of data which may be used to restore the original after a data loss.
MICROSOFT ACCESS
Microsoft Access is a database package. It is an important part of MS Office. It is a relational database application. A database is an organized collection of records. Telephone and address books are examples of paper databases. With Access, you can create a computerized database. For example, you can use Access to organize the students who attend a school, the courses they take, and the instructors who teach them. After you create an Access database, you can search it, manipulate it, and extract information from it. Table is the basic unit of recording data in Access.

To start Access
You use windows to interact with Access. To begin, start Access 2007. You screen will look similar to the one shown here

In the upper-left corner of the Access window is the Microsoft Office button. When you click the button, a menu appears. You can use the menu to create a new file, open an existing file, save a file, and perform many other tasks.

The Quick Access Toolbar
Next to the Microsoft Office button is the Quick Access toolbar. The Quick Access toolbar provides you with access to commands you frequently use. By default, Save, Undo, and Redo appear on the Quick Access toolbar. You use Save to save an object, Undo to roll back an action you have taken, and Redo to reapply an action you have rolled back.

**The Title Bar**

The Title bar is located at the top in the center of the Access window. The Title bar displays the name of the database on which you are currently working.

**The Ribbon**

In Access 2007, you use the Ribbon to issue commands. The Ribbon is located near the top of the Access window, below the Quick Access toolbar. At the top of the Ribbon are several tabs; clicking a tab displays related command groups. Within each group there are related command buttons. You click buttons to issue commands or to access menus and dialog boxes. You may also find a dialog box launcher in the bottom right corner of a group. When you click the dialog box launcher, a dialog box makes additional commands available.

**Access Objects**
• You click the double down-arrows to view objects. The double down-arrows change to doubleup-arrows. ..
• You click the double up-arrows to hide objects. The double up-arrows change to double downarrows.

<table>
<thead>
<tr>
<th>Objects</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tables</td>
<td>In Access, data is stored in tables. A table is a set of columns and rows, with each column referred to as a field. Each value in a field represents a single type of data. Each row of a table is referred to as a record.</td>
</tr>
<tr>
<td>Queries</td>
<td>You use queries to retrieve specific data from your database and to answer questions about your data. For example, you can use a query to find the names of the employees in your database who live in a particular state.</td>
</tr>
<tr>
<td>Forms</td>
<td>Forms give you the ability to choose the format and arrangement of fields. You can use a form to enter, edit, and display data.</td>
</tr>
<tr>
<td>Reports</td>
<td>Reports organize or summarize your data so you can print it or view it onscreen. You often use reports when you want to analyze your data or present your data to others.</td>
</tr>
<tr>
<td>Macros</td>
<td>Macros give you the ability to automate tasks. You can use a macro to add functionality to a form, report, or control.</td>
</tr>
<tr>
<td>Modules</td>
<td>Like macros, modules give you the ability to automate tasks and add functionality to a form, report, or control. Macros are created by choosing from a list of macro actions, whereas modules are written in Visual Basic for Applications.</td>
</tr>
</tbody>
</table>

You double-click an object to open the object. Objects that are open appear on tabs. Right-click a tab to view a menu of options you can perform, such as save the object, close the object, or change the view.

**Change Views**

A view is a way of looking at an object. For example, in Access, data is stored in tables. Two of the possible ways you can view a table are Datasheet view and Design view. You can see the data contained in a table in Datasheet view. You can see the design of a table in Design view. When you open an object, buttons appear in the lower-right corner of the Access window. You can use the View button on the Home tab to change views, or you can click the proper button in the lower-right corner of the window.

**Close a Database and Exit Access**

This completes the introduction to Access using the North wind database. The following describes how you close a database and exit Access.

**To close a database:**
1. Click the Microsoft Office button. A menu appears.
2. Click Close Database. Access closes the database.

**To exit Access:**
1. Click the Microsoft Office button. A menu appears.

**Create a Database**

When you start Access, the Getting Started with Microsoft Office Access screen appears. You can use this screen to create a database. Within a database, you can do such things as enter data, create reports, and retrieve data. You can create a blank database or you can use one of the templates provided by Microsoft. When you use a template, Access creates forms you can use to enter data, reports you can use to retrieve data, and more. You can modify the forms, reports, and other objects to suit your needs. The following templates are included with Access: Assets, Contacts, Events, Faculty, Issues, Marketing Projects, Projects, Sales Pipeline, Students, and Tasks. Other templates are available online. Each template creates a database related to the title. For example, the Faculty template creates a faculty database that includes tables, queries, forms, and reports related to faculty.

In Access, you use tables to store data, queries to retrieve data, forms to enter data, and reports to display data.

*To use a template to create a database:*

2. Click Blank Database.
3. Type the name you want to give your database in the File Name field. Access will automatically append .accdb to the name.
4. Click the Browse button. The File New Database window appears.
5. Locate the folder in which you want to store your database. Note that the name of the file appears in the File Name field.
6. Click OK.
7. Click the Create button. Access creates the database and opens a datasheet with the Table Tools available to you.

Datasheet
In Access, data is stored in tables. A datasheet displays the information stored in a table in columns and rows. The columns are called fields and the rows are called records. You can use a datasheet to create a table, enter data, retrieve data, and perform other tasks.

Creating Microsoft Access Tables
Tables are the foundation of an Access database. Access stores data in tables. This lesson teaches you how to create a table, add fields to a table, assign data types to fields, and set field properties.

Understanding Tables
A table is a set of columns and rows. Each column is called a field. Within a table, each field must be given a name and no two fields can have the same name. Each value in a field represents a single category of data. For example, a table might have three fields: Last Name, First Name, and Phone Number.

After Access creates a blank database, it opens in Datasheet view and makes available the tools you need to create a table. Datasheet view displays a table as a set of columns and rows. When you view a blank database for the first time in Datasheet view, you see a column named ID. This column is by default the...
primarykeyfield.

A primarykey is a field or combination of fields that uniquely identify each record in a table. Not two records in a table should have the same value in every field. For example, the following should not occur in a table:

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saju</td>
<td>Ravi</td>
<td>Calicut</td>
</tr>
<tr>
<td>Saju</td>
<td>Ravi</td>
<td>Calicut</td>
</tr>
</tbody>
</table>

In cases like this, you can use the ID field as the primary key field and use it to make each record unique. The ID field has a data type of AutoNumber; as a result, Access automatically creates a unique number for each record in the database. The resulting table will look like the one shown here:

<table>
<thead>
<tr>
<th>ID</th>
<th>Last Name</th>
<th>First Name</th>
<th>City</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Saju</td>
<td>Ravi</td>
<td>Calicut</td>
</tr>
<tr>
<td>2</td>
<td>Saju</td>
<td>Ravi</td>
<td>Calicut</td>
</tr>
</tbody>
</table>

When you save your table for the first time, Access gives you the opportunity to name your table. Each table name must be unique; hence, two tables in the same database cannot have the same name. The table names should describe the data in the table; can consist of letters, numbers, and spaces; and can be up to 64 characters long. When choosing a table name, try to keep it short.

You can save a table by clicking the Save button on the Quick Access toolbar or by right-clicking the Tables tab and then choosing ‘Save’ from the menu that appears.

To add fields to a table:
1. Click the Add New Field column label.
2. Activate the Datasheet tab.
3. Click Rename in the Fields & Columns group.
4. Type the field name.
5. Press Enter. Access creates the field.
6. Type the next field name. Access creates the field. Continue until you have created all of the field in your table.
7. Press Enter without entering a field name to end your entries. Or
1. Right-click the Add New Field column label. A menu appears.
2. Click Rename Column.
3. Type the field name.
4. Press Enter. Access creates the field.
5. Type the next field name. Access creates the field. Continue until you have created all of the fields in your table.

**Name and Save a Table**

After you create a table, you must name and save it.

To name and save a table:

1. Click the Save button on the Quick Access toolbar. The Save As dialog box appears.
2. Type the name you want to give your table.
3. Click OK. Access names your table.

**Understanding Data Types**

In Access, you use data types to specify the type of data each field can capture. A field with a data type of text can store alphabetic characters and numbers. Generally speaking, you cannot perform
mathematical calculations by using a text field. For example, you can use a text field to store a House address. Unless you do some manipulation, you cannot use the numbers in the street address in mathematical calculations. The following list summarizes all the field data types available in Microsoft Access, their uses, and their storage sizes.

**Text** - Use for text or combinations of text and numbers, such as addresses, or for numbers that do not require calculations, such as phone numbers, part numbers, or postal codes. Stores up to 255 characters.

**Memo** - Use for lengthy text and numbers, such as notes or descriptions. Stores up to 65,536 characters.

**Number** - Use for data to be included in mathematical calculations, except calculations involving money (use Currency type).

**Date/Time** - Use for dates and times. Stores 8 bytes.

**Currency** - Use for currency values and to prevent rounding off during calculations. Stores 8 bytes.

**AutoNumber** - Use for unique sequential (incrementing by 1) or random numbers that are automatically inserted when a record is added. Stores 4 bytes.

**Yes/No** - Use for data that can be only one of two possible values, such as Yes/No, True/False, On/Off. Null values are not allowed. Stores 1 bit.

**OLE Object** - Use for OLE objects (such as Microsoft Word documents, Microsoft Excel spreadsheets, pictures, sounds, or other binary data) that were created in other programs using the OLE protocol. Stores up to 1 gigabyte (limited by disk space).

**Hyperlink** - Use for hyperlinks. A hyperlink can be a UNC path or a URL. Stores up to 64,000 characters.

**Views**

Views are different ways of looking at the same object. Tables have four views:

**Datasheet view** - to create a table, edit data, or view data

**Pivot Table view** - to create a pivot table

**Pivot Chart view** - to create a pivot chart

**Design view** - to create a table or modify an existing table.

**Design View**

Access provides several ways to view the objects in your database. You can use Design view to create or modify an Access table. You can use the View button on the Home tab or the Table Design button on the Create tab to change to Design view.

To use Design view to create a new table:
1. Activate the Create tab.
2. Click Table Design in the Tables group. Access changes to Design view and the Table Tools become available.
3. Type the first field name in the Field Name field.
4. Press the Tab key.
5. Click the down-arrow that appears when you click in the Data Type field and then select a data type.
6. Click Primary Key if the column you created is a primary key. A small key appears next to the field name.
7. Press the Tab key.
8. Type a description. The description is optional.
9. Press the Tab key. Access moves to the Field Name field.
10. Repeat steps 3 through 10 until you have created all of your fields.

To set field properties:
1. Click the field for which you want to set the field properties.

2. Activate the General tab in the Field Properties area.

3. Set the properties you want to set.

4. Repeat steps 1 through 3 until you have set all the properties for all fields.

**To change the view:**

1. Activate the Home tab.

2. Click the down-arrow under the View button. A menu appears.

3. Click the view you want. Access changes to the view you chose.

**Create Relationships**

In Access, you store data in multiple tables and then use relationships to join the tables. After you have created relationships, you can use data from all of the related tables in a query, form, or report.

**Primary key and foreign key**
A primary key is a field or combination of fields that uniquely identify each record in a table. A foreign key is a value in one table that must match the primary key in another table. You use primary keys and foreign keys to join tables together—in other words, you use primary keys and foreign keys to create relationships.

There are two valid types of relationships: one-to-one and one-to-many. In a one-to-one relationship, for every occurrence of a value in table A, there can only be one matching occurrence of that value in table B, and for every occurrence of a value in table B, there can only be one matching occurrence of that value in table A. In a one-to-many relationship, for every occurrence of a value in table A, there can be zero or more matching occurrences in table B, and for every one occurrence in table B, there can only be one matching occurrence in table A.

If you delete Student ID 1 from the Students table, Student ID 1 is no longer valid in the Payments table. Referential integrity prevents you from deleting Student ID 1 from the Students table. Also, if the only valid Student IDs are 1, 2, and 3, referential integrity prevents you from entering a value of 4 in the Student ID field in the Payments table. A foreign key without a primary key reference is called an orphan. Referential integrity prevents you from creating orphans.

**Create relationships:**

1. Close all tables and forms. (Right-click on the tab of any Object. A menu appears. Click Close All.)
2. Activate the Database Tools tab.
3. Click the Relationships button in the Show/Hide group. The Relationships window appears.
4. If anything appears in the relationships window, click the Clear Layout button in the Tools group. If you are prompted, click Yes.
5. Click the Show Table button in the Relationships group. The Show Table dialog box appears.
6. Activate the Tables tab if your relationships will be based on tables, activate the Queries tab if your relationships will be based on queries, or activate the Both tab if your relationships will be based on both.
7. Double-click each table or query you want to use to build a relationship. The tables appear in the Relationships window.

8. Click the Close button to close the Show Table dialog box.

9. Drag the Primary table’s primary key over the related table’s foreign key. After you drag the primary key to the related table’s box, the cursor changes to an arrow. Make sure the arrow points to the foreign key. The Edit Relationships Dialog box appears.

10. Click the Enforce Referential Integrity checkbox.

11. Click Create. Access creates a one-to-many relationship between the tables.

12. Click the Save button on the Quick Access toolbar to save the relationship.
Creating Microsoft Access Queries

Queries are very useful tools when it comes to databases and they are often called by the user through a form. They can be used to search for and grab data from one or more of your tables, perform certain actions on the database and even carry out a variety of calculations depending on your needs. Microsoft Access allows for many types of queries, some of the main ones being select, action, parameter and aggregate queries. They can be thought of as just another part of your database – essentially an object like a table or a macro. When it comes time to build a query for your database, you have two ways to go about creating it.

1. Either use the Query Wizard that Microsoft Access provides for you, or
2. Create your own queries from scratch.

Query types:

Select Query

The select query is the simplest type of query and because of that, it is also the most commonly used one in Microsoft Access databases. It can be used to select and display data from either one table or a series of them depending on what is needed. It is the user-determined criteria that tell the database what the selection is to be based on. After the select query is called, it creates a "virtual" table where the data can be changed, but at no more than one record at a time.

Action Query

When the action query is called, the database undergoes a specific action depending on what was specified in the query itself. This can include such things as creating new tables, deleting rows from existing ones and updating records or creating entirely new ones. Action queries are very popular in data management because they allow for many records to be changed at one time instead of only single records like in a select query.

Four kinds of action queries are:

1. **Append Query** – takes the set results of a query and "appends" (or adds) them to an existing table.
2. **Delete Query** – deletes all records in an underlying table from the set results of a query.
3. **Make Table Query** – as the name suggests, it creates a table based on the set results of a query.
4. **Update Query** – allows for one or more field in your table to be updated.

Parameter Query
In Microsoft Access, a parameter query works with other types of queries to get whatever results you are after. When using this type of query, you are able to pass a parameter to a different query, such as an action or a select query. It can either be a value or a condition and will essentially tell the other query specifically what you want it to do.

**Aggregate Query**

A special type of query is known as an aggregate query. It can work on other queries (such as selection, action or parameter) just like the parameter query does, but instead of passing a parameter to another query it totals up the items by selected groups.

**Designing and running queries**

Following are the steps for designing queries in MS Access

1. **Open the Query Design Grid**

   The first stage is to select the CREATE TAB and then go to the OTHER group on the far right of the ribbon. Then click on the QUERY DESIGN ICON to bring up the query design grid.

2. **Select Table for Query**

   The next stage is to select which table you are going to use in this query. When the query design grid opened, the SHOW TABLE pop up window should also have opened. If necessary you can open this window manually by clicking the SHOW TABLE icon in the QUERY SET UP group on the Access Ribbon.
Suppose there is only one table in your database - TABLE1. This should be highlighted when the window opens, but if not, just click on it once. Next click ADD. When you close the pop-up window by clicking x, you should see a box labeled TABLE1 above the query design grid.

3. **Select fields from Table**

In the table1 box, you will see a list of its field names. We are going to use all the fields in this query, so select each one individually by double clicking on their names. You will now see the field names at the top of each column in the Query Design Grid.

4. **Enter query criteria**

As you may remember, the purpose of our query is to extract records where the persons name is greater than or equal to 35. To do this we enter the criteria into the appropriate cell of the query design grid. In this case you need to go to the AGE column of the CRITERIA row, and enter the formula >=35.

5. **Save and Run Query**

Click the save icon above the Access Ribbon. When prompted for the query name, just use the default QUERY1. To run your query, click the RUN icon in the RESULTS GROUP of the Access Ribbon. You should now be presented with a datasheet displaying your query results - JOHN JONES 35 and JOE BROWN 39.
Creating Reports

Reports organize and summarize data for viewing online or for printing. A detail report displays all of the selected records. You can include summary data such as totals, counts, and percentages in a detail report. A summary report does not list the selected records but instead summarizes the data and presents totals, counts, percentages, or other summary data only. Access has several report generation tools that you can use to create both detail and summary reports quickly. This lesson teaches you how to create reports.

Use the Report Button

The Report button creates a simple report that lists the records in the selected table or query in a columnar format.

By using the Report button:

1. Open the Navigation pane.
2. Click the table or query on which you want to base your report.
3. Activate the Create tab.
4. Click the Report button in the Reports group. Access creates your report and displays your report in Layout view. You can modify the report.

: After you create a report, you can save it.
1. Click the Save button on the Quick Access toolbar. Access saves the report unless you are saving for the first time. If you are saving for the first time, the Save As dialog box appears.

2. Type the name you want to give your report.

3. Click OK. Access saves the report. You can now access the report by using the Navigation pane.

**Use the Report Wizard**

You can also use the Report Wizard to create a report. The Report Wizard provides you with more flexibility than you get by using the Report button. You can choose the tables and fields, group the data, sort the data, summarize the data, choose a layout and orientation, apply a style, and title your report.

Follow the steps shown here to create a report by using the Report Wizard:

**Create a report by using the Report Wizard:**

Open the Report Wizard

1. Activate the Create tab.


**Select tables, queries and fields**

When using the Report Wizard, you can use fields from multiple tables and/or queries if the tables/queries have a relationship.

1. Click the down-arrow next to the Table/Queries field and then click the table from which you want to select fields.

2. Click a field and then click the single-right arrow to select a single field, click the double-right arrows to select all fields, click a field and then click the single-left arrow to deselect a single field, or click the double-left arrow to deselect all fields.

3. Repeat steps 1 and 2 for each table from which you want to select fields.

By using report wizard we can format and modify report in Access.

A. Group
When using the Report Wizard, you can group data. For example, if your data is grouped by the Department field and the records in the Department field have values such as Administration, Computer Science, and English. Access will group all of the data for the Administration department together, all of the data for the Computer Science department together, and all of the data for the English department together.

B. Sort and summarize
By using the Report Wizard, you can create up to four levels of sort. Access sorts the first level, and then sorts the second level within that sort, and so on. If you have grouped your data, you can summarize it by displaying the sum, average, and minimum or maximum value for each numeric field.

C. Layout and orientation
You can choose the layout and orientation of your report.

D. Style
A style is a set of formats consisting of such things as background colors, fonts, font colors, and font sizes. Access supplies predesigned styles that format titles, labels, and more. When you choose a style, the left side of the window displays a preview.

1. Click to select a style.
2. Click Next. The Report Wizard moves to the next page.

E. Create a title
On the final page of the Report Wizard, you can title your report. The title appears at the top of the report and on the Navigation pane.
1. Type the title you want to give the report.
2. Click Finish. Access creates, saves, and opens your report in Layout view.

F. Printing of report

Print a Report
Often, the people who use Access data only see a printed report. In Print Preview, you can see exactly how your report will look when printed, you can make changes to it, and you can print it.
To print, click the Print button in the Print group. The Print dialog box opens and you can select your print options.

To change to print Preview:
1. Open your report.
2. Activate the Home tab.
3. Click the down-arrow under the View button. A menu appears.
4. Click Print Preview. Access changes to Print Preview.

Questions

1. What is database system? What are its features?
2. What is DBMS? Explain its components and advantages?
3. Who is DBA? What are his functions?
4. Discuss types of database architecture?
5. Discuss database security and security measures?
6. What is MS Access? What is its use?
7. How do you create a table in MS Access?
8. What is RDBMS? And how to you create relationship?
9. Describe the steps for designing simple Query?
10. Discuss various types of queries in MS Access?
11. How do you create and print report in Access?
12. Explain the terms-primary key, foreign key and referential integrity.
CHAPTER 5
INTERNET

Internet is the world’s largest computer network. The word internet was coined from the word “Inter
connection and Network”. The internet is a network or more precisely “Inter-network” of hundreds
of connecting networks made up of different types of computers all the world that can share
messages and information with one another. It is described as the network of networks.

HISTORY OF INTERNET

The history of the internet begins with the development of electronic computers in the 1950’s. Initial
concepts of packet networking originated in several computer science laboratories in the United
States, Great Britain and France. The US Department of defence awarded contracts as early as the
1960’s for packet network systems, including the development of the ARPANET (which would
become the first network to use the Internet Protocol).

The internet is not a new phenomenon. In 1973, the US Defence Advanced Research Projects
Agency (DARPA) initiated a research program to investigate techniques and technologies for
interlinking packet networks of various kinds. The objective was to develop communication
protocols which would allow networked computers to communicate transparently across multiple,
linked packet networks. This was called the internetting project and the system of networks which
emerged from the research was known as the “Internet”.

Access to the ARPANET was expanded in 1981 when the National Science Foundation (NSF)
funded the Computer Science Network (CSNET). In 1982, the Internet Protocol Suite (TCP/IP) was
introduced as the standard networking protocol on the ARPANET. Electronic mail over ARPANET
was a great success. This has given birth to the INTERNET. In its early days, the internet was not
used for commercial purposes mainly because it was funded through research grants from the NSF
and other government agencies. It was mainly used for technical, academic and scientific
research. The main turning point in the history of internet was in 1991, when NSF removed
restrictions and allowed commercial traffic into internet.

In April 1995, the US Government further relaxed control of the internet to independent
government to independent governing bodies, which taken away the restrictions for Internet access. Ever since
commercial use of internet was allowed, the growth in subscribers and traffic has been phenomenal.

According to Internet Society estimates, the internet now has 30 million users on 10 million
computers connected to over 24000 networks in over 100 countries. It is often said that there has
been no other technology or innovation in the modern

INTERNET PROTOCOLS

A communication protocol allows different kinds of computers using different operating systems to
communicate with one another. It is highly essential because internet is not made up of any single
type of computer system. Instead there are great diversities found in the computers used on the
internet. The user connected on any network on the internet can communicate with others or software located on any other network connected to the internet using common set of protocols. An Internet Protocol is a set of standards or rules for exchanging information between computer systems in a network. The most commonly used protocols are:

1. Transmission Control Protocol / Internet Protocol (TCP/IP)
2. File Transfer Protocol (FTP)
3. Hyper Text Transfer Protocol (HTTP)
4. Telnet
5. Gopher
6. Wide Area Information Service (WAIS)

1. Transmission Control Protocol / Internet Protocol (TCP/IP)

TCP/IP is actually a collection of protocols that govern the way travel from one computer to another computer across networks. A user connected on any network on the internet can communicate with people or software located on any other network connected to the internet using this common set of protocols, the TCP/IP. Thus any computer that speaks the language TCP/IP can talk to any internet machine. Simply this is the set of standards (Protocols) for data transmission and error correction that allows the transfer of data from one computer to another computer over internet.

2. File Transfer Protocol (FTP)

FTP is the protocol or set of rules, which enables files to be transferred between computers. It is a powerful tool which allows files to be transferred from one computer to another computer. FTP works on the client/server principle. A client program enables the user to interact with a server in order to access information and services on the server computer. Files that can be transferred are stored on Server computers. A client can access these files only through a client application program. This program helps a client computer to locate required file to be transferred and starts the process of transfer.

To access other computer, user has to normally supply a login name and password and after that he can access the computers file dictionary system and can upload (send) and download (receive) files.

3. Hyper Text Transfer Protocol (HTTP)

HTTP is an internet standard or set of rules that allows the exchange of information on the World Wide Web (WWW). Hyper Text is a method of preparing and publishing text ideally suited to the computer, in which users can select their own text. To prepare hyper text, the whole material should be divided into small segments such as single pages of text. These small segments are called nodes. Then hyper links (also called anchors) are embedded in the text. When the user clicks on a hyper link, the hyper text software displays a different node. The process of navigating among the nodes
linked in this way is called ‘browsing’. A collection of nodes that are interconnected by hyperlinks is called a Web.

4. Telnet
Telnet is an internet protocol or set of rules that enables internet users to connect to another computer linked to the internet. This process is also called as remote login. The user’s computer is referred to as the local computer and the computer being connected to is referred to as remote or host computer. Once access is established between local and host computer, local computer can give commands so that they are executed in the host computer.

5. Gopher
Gopher is a protocol linked to the internet to search, retrieve and display documents from remote sites on the internet. It is a menu based program that helps the user to find files, programs, definitions and other topics that the user specifies. Gopher protocol allows the user to free from the troubles of specifying the details of host, directory and file names.

6. Wide Area Information Service (WAIS)
WAIS stands for Wide Area Information Service. WAIS is an internet search tool and describes as a protocol for computer to computer information retrieval. It is a program that permits the user to search information worldwide based on a service of key words. WAIS has the capacity of simultaneously searching in more than one database.

INTERNET ADDRESSING
Internet address is used to identify people, computers and information related with internet.

IP ADDRESS
IP Address is required to communicate with other computers in the net. One must know the address of the computer to transfer files, send e-mail messages etc. An IP address consists of four sections separated by periods. Each section contains a number ranging from 0 to 255. Example 128.43.7.12.

DOMAIN NAME
A domain name is a name used to identify and locate computers connected to the Internet. No two organisations can have the same domain name.
A domain name always contains two or more components separated by periods called ‘dots’. Eg: Microsoft.com, Indiacapital.com. The last portion of the domain name is the top level domain name and describes the type of organisation holding that name. The important types of top level domain names are the following:

.com - Commercial institutions
.edu - Educational institutions
.org - Miscellaneous organisations not included above.
Country codes - A two letter abbreviation for a particular country.
Eg: “in” for India, “uk” for United Kingdom or “fr” for France.
INTERNET TOOLS

Internet provides several software tools to take maximum benefits from the net. It is possible to communicate with people all around the world. Information on various subjects can be accessed very easily. A user can navigate from one topic to another and download any information required by him. Friendship can be built with people of related interest from around the world. The following are some of the services that can be exploited by an internet user:

1. E-mail
2. FTP
3. Usenet
4. Telnet
5. Internet Relay chat (RTC)
6. World Wide Web
   1. **Electronic Mail (E-mail)**
   E-mail is an electronic message sent from one computer to another. Messages can be prepared and sent reliably over communication networks from the computer of the sender to be received at the computer of recipient. This facility allows to exchange mail with millions of people all over the world at economical rates.

   **E-mail address**
   Electronic messages are delivered to the recipient at his e-mail address. E-mail address is a series of characters that precisely identifies the location of a person’s electronic mail box. On the internet-mail address consists of a mail box name followed by at sign @ and the computers domain name.

   2. **File Transfer Protocol (FTP)**
   This is another facility available in the internet. FTP (File Transfer Protocol) is the simplest and most secure way to exchange files over the internet.

   FTP is the protocol or set of rules, which enables files to be transferred between computers. It is a powerful tool which allows files to be transferred from one computer to another computer.

   FTP works on the client / server principle. A client program enables the user to interact with a server in order to access information and services on the server computer. Files that can be transferred are stored on Server computers. A client can access these files only through a client application program. This program helps a client computer to locate required file to be transferred and starts the process of transfer.

   To access other computer, user has to normally supply a login name and password and after that he can access the computers file dictionary system and can upload (send) and download (receive) files.

   3. **Usenet**
   Usenet or User’s Network is not a computer network. In the physical sense, it is a vast body of news group that are distributed all around the world by computers called ‘news server’.
4. **Telnet**
This is another important facility available in Internet. Telnet allows internet users to access another Computer linked to the internet. The user’s computer is called local computer and the computers to which connection is established is known as remote computer.

5. **Internet Relay chat (RTC)**
Internet Relay Chat is a real-time internet-based chat service in which one can find ‘live’ participants from the world over. It is a multi-user chat system that allows many people to communicate simultaneously across the Internet. Developed in 1988 by J. Oikarimen in Finland, the IRC offering a unique type of talking experience on the net has been extensively for live coverage of world events, news, and sports commentary. The IRC network on the internet consists of multiple interconnected servers. The IRC service provides a number of channels; public, private, secret or invisible.

6. **World Wide Web**
World Wide Web or simply web is one of the main reasons for the growth popularity of the internet. Information can be accessed on the internet through World Wide Web. Web is a system of organising, linking and providing access to related internet files, resources, and services. Files can be accessed at the click of the mouse. This is mainly due to the arrangement of the files based on a hyper-text or hyper-media approach.

**INTRANET AND EXTRANET**

**INTRANET**
Intranet is a private network of any organisation which allows using only within the organisation itself. The main aim of such network is to share part of the organisation’s information and computer resources among its employees geographically disperse. It is also used for monitoring workgroup or teleconferencing within the organisation. Such network does not allow an external user to access the company data. Example of such network can be company Leave Management System or Human Resources System.

**Advantages of Intranet.**
1. Ease of use.
2. Publishing ease.
3. Low cost.
4. Low maintenance.
5. Easy Software distribution.

**Disadvantages of Intranet.**
1. Short term risk.
2. Less back-end integration.
EXTRANET
Extranet is a business to business intranet that allows limited controlled, secure access between a company’s internet and authorised users from remote locations. The information stored on the web of one organisation can be shared by other organisations if they are in good terms. Extranet is also a private network of an organisation. However, it also allows trusted external partners or clients such as suppliers, customers and business partners to access the work. An intranet extended to trusted external parties becomes an extranet. An external party would have limited access to the network compared to an internal employee of the organisation.

ELECTRONIC DATA INTERCHANGE (EDI)
Computer to computer exchange of business information has become increasingly popular form of electronic commerce. EDI is important because it enables the firms to exchange business information faster, more cheaply and more accurately than possible using paper based documents. EDI is the electronic exchange of business documents in a standard, computer processable, universally accepted format between trading partners. It is a standard for the electronic exchange of business documents such as invoices and purchase orders. EDI is used in manufacturing, shopping, warehousing, pharmaceuticals, constructions, petroleum, banking, insurance, retailing, government etc.

Benefits of Electronic Data Interchange (EDI)
The benefit of electronic trading is well documented. Here are the top five reasons why businesses adopt EDI.

1. Remove document re-keying
By removing the manual keying of key business documents such as Orders, Invoices, Acknowledgments and Dispatch Notes your company can benefit significantly by:
   - Reduced labour costs
   - Elimination of human keying errors
   - Faster document processing
   - Instant document retrieval
   - Remove reliance on the postal service

2. Eliminate Paper
Paper-based trading relationships have some inherent disadvantages when compared with their electronic trading equivalents:
   - Stationery and printer consumable costs
   - Document storage costs
   - Lost documents
   - Postage costs
3: Reduce lead times and stockholding
- Electronic trading documents can be delivered far more quickly than their paper counterparts, thus the turnaround time from order to delivery can be reduced.
- By using EDI for forecasting and planning, companies are able to get forward warning of likely orders and to plan their production and stock levels accordingly.
- Companies receiving advanced shipping notes or acknowledgments know in advance what is actually going to be delivered, and are made aware of shortages so alternate supplies can be sourced.
- Integrating electronic documents means they can be processed much faster, again reducing lead times and speeding up payments.

4: Increase quality of the trading relationship
- Electronic trading documents when printed are much easier to read than copies faxed or generated on multi-part stationery by impact printers.
- Accurate documents help ensure accurate supplies.
- Batches of electronic documents are usually sequentially numbered, therefore missing documents can easily be identified, not causing companies to wade through piles of paper.

5: Competitive Edge
Because electronic data interchange (EDI) makes you attractive to deal with from your customers' point of view, and you are in their eyes cheaper and more efficient to deal with than a competitor trading on paper, your costs will be lower because you will require less manpower to process orders, deliveries or payments.

It is no accident that the leading UK retailers all rely on EDI for placing orders and receiving invoices - they know the benefits they get and the costs that can be saved.

Drawbacks of EDI
1. High cost.
2. Limited accessibility.
3. Rigid requirements.
4. Partial solutions.
5. Closed world.

EDI standards
There are two main standards that define EDI, ANSI ASC X12 and EDIFACT.

ANSI ASC X12
The ANSI ASC EDI standard defines the data structure and content for business transactions transmitted between computer applications. The data is grouped to represent all the information required for a particular business function, such as a purchase order.
ASC X12 specifies business forms by defining standard data elements with dictionaries that specify name, length of data field, description, data type, and meaning.

Full X12 standard consists of:

- x12.3 Data element dictionary
- x12.5 Interchange structure-the envelope
- x12.6 Application control structure-the formal description of the EDI architecture
- x12.22 Directory of lists of related data elements-e.g. multiple lines of address

**UN/EDIFACT**

United Nations Rules for Electronic Data Interchange For Administration, Commerce and Transport (UN/EDIFACT) is a set of internationally agreed upon standards, directories and guidelines for the electronic interchange of structured data that relate, in particular, to trade in goods and services.

EDIFACT consists of data elements (a value), segments (a logical group of data elements), and messages (a collection of segments relating to a business function), and rules for combining them.

Each data element has attributes such as:

- coded tag or identifier (code dictionary)
- title
- plain text description
- format (length and datatype or class)
- year of insertion in Directory (previous issue in parenthesis)

The full standards consist of:

- Data element directory (ISO 7372)
- Segment dictionary
- Message dictionary
- Syntax which defines a hierarchical structure with implicit data element identification, flexible length data structures and mandatory or conditional status of data elements and segments.

**EDI Applications**

EDI, applied to the different business processes, allows more streamlined and efficient operations of your commercial, purchasing and administrative departments with companies both supplying and receiving goods. As a working system, “Electronic Data Interchange” is designed to automatically integrate your business documents into your ERP or Internal Management System. The higher the number of trading partners (customers, suppliers, majestic operators, etc.) and EDI transactions interchanged with them, the greater the benefits to be obtained through EDI implantation. These benefits translate as important reductions in costs which, depending on the level of rollout, may
reach 90% compared with the same process carried out with business documents managed by other means such as post, fax or mail.

1. Order Integration
Creating, sending and follow-up of supply orders generated by the purchasing departments involves dedicating important technical and human resources to processing the orders to suppliers in the right time and format.

For suppliers, the interpretation and typing of these orders in the internal management system entails a large amount of work to be done by the commercial and administration departments of the vendor companies. In any case, we are talking about critical operations both for buyers and suppliers, since at the end of the day they all depend on the provision of an efficient and high quality service to end customers of both parties.

2. Despatch Advice Integration
The despatch advice, as a document accompanying the goods in transit to the customer, is a key business transaction to verify that the goods actually received correspond to the purchase order specifications. The ability to perform these checks prior to issuing the invoice lets you make adjustments if there are any differences with respect to the initial purchase order, ensuring that your final payment or billing documents are correct, whether you are sending or receiving the goods.

3. Integrating Invoices
Automating the billing process is a strategic element that can achieve savings of up to 90% compared to managing these documents manually. The volume of payable invoices often handled by accounting departments’ calls for measures to optimize the operations associated with revision, validation, registration and payment to the supplier. These are key tasks for any purchasing department, since management efficiency depends on them.

Likewise, invoice issuers have to devote costly resources to critical aspects of the commercial process such as checking deliveries and periodic billing for clients, as well as the manual tasks of printing, enveloping, stamping and sending. Other tasks also require regular follow-up to check receipt of the invoice on arrival and its status in the Accounts Payable Department.

Integration of electronic invoices lets you automate almost all of these steps, providing great competitive advantages for senders and receivers that translate as better management efficiency ratios, and consequently in significant cost savings.

4. e-Air Waybill
The e-Air Waybill provides airlines, freight forwarders and customs authorities with one standard for the automatic electronic exchange of standardized freight documents, at any airport worldwide operating under the new e-freight system.

e-Freight System
An initiative developed by IATA (International Air Transport Association), designed to replace paper in air freight cargo operations with a new system based on electronic data interchange

**EDICOM Air: e-Air Waybill solution**

The system’s international scalability involves participation of the customs authorities to regulate the process and the documents to be declared in freight operations. EDICOM has developed the Public Administrations HUB, a communication module that links up directly and securely with the customs of each country signed up to the IATA model.

**EDI Technology**

Through the use of EDI technology (Electronic Data Interchange) to exchange transport documents, we achieve a universal electronic data transfer system. The EDICOM e-Air Waybill platform automates the creation of all freight documents by applying the set standard (XML), relieving businesses of the burden of paperwork.

**QUESTIONS**

1. What is a URL?
2. What is the internet?
3. What is IRC?
4. What is domain name?
5. What is IP Address?
6. What is an email?
7. What is a direct connection?
8. What is modem?
9. What do you mean by DSL?
10. What is top level domain name?

**Paragraph Questions**

1. What is the difference between a dial up connection and a direct connection?
2. How does an email work?
3. What is FTP and HTTP?
4. Explain TELNET, Gopher and WAIS.
5. What are the TCP/ IP and how does it work?
6. Give an account of internet administration?
7. How internet is useful for education?

**ESSAY QUESTIONS**

1. Briefly explain the history of internet.
2. Briefly explain the various facilities available on internet.

--------